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1 Introduction

About IVD Solutions

IVD Solutions™ is a measurement system for In Vivo Dosimetry—the real time measurement of 
radiation dose administered to a patient during therapy. 

The equipment consists of two models (Figure 1-1): 

• Model 1136, wireless rf-IVD2—connected by a wireless link within the treatment vault. This 
eliminates cable tangle on the floor of the treatment room, providing a neater, safer 
environment.

• Model 1137, wired IVD2—connected with a cable.

Figure 1-1. Model 1136 wireless and model 1137 wired detector pods

The two models are identical except for the wireless circuits and a battery in the Model 1136. 

You can connect up to four diode detectors to each Pod with snap-on LEMO connectors. For 
example, you might have a 1-4 MV detector on channel A, a 6-12 MV diode on channel B, a 15- 25 
MV diode on channel C, and an electron diode on channel D. This would allow you to use a single 
Pod to cover most treatment ranges. Or you could set up another Pod to measure multiple points 
simultaneously, such as entrance and exit doses. 

Each Pod contains a complete measurement system, including electrometer, calibration memory, 
and communication circuits. The other parts of the system are common to all models. For exam-
ple, cables, power supply, Control Module, and PC application software, are common and can be 
used with either model. See “Parts and accessories for the IVD Solutions” on page 9.

NOTE: Components of Models 1133/1135 can be intermixed with components of Model 1136/
1137 with minor changes to hardware, software, and firmware. see “Using Model 1133/1135 com-
ponents” on page 83.

Control devices

Control devices include the following:

• Control Module—desktop operating device with keypad and display 

• Computer—special IVD application software on your computer
About IVD Solutions 1



You can use either device and you can switch back and forth between them.

Control module

A Control Module is part of every system. You control the system directly with push buttons on 
the Control Module, and you see the results of measurements on the built-in display.

Figure 1-2. Control module

The Control Module can control one measurement Pod at a time. You can print reports on the 
optional thermal printer.

PC software

You can also control the system from your personal computer (PC) using the Windows software 
included with your system. The program collects dose measurements from the Pods and displays 
the dose results on the screen. You operate the system by clicking buttons on the PC screen (Fig-
ure 1-3).

Figure 1-3. PC software control display
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The software is provided on a CD and can be installed on any computer (Windows 95 or higher). 
Reports can be printed on any printer connected to the computer or network.

If you want to use more than one Pod (more than 4 diodes) at the same time, you MUST use the 
PC software. Updated software can be found on the Sun Nuclear Corporation web site.

See “Software operation” on page 41.

Applications

Features
• Wireless connection—in model 1136, the wireless connection between patient and the con-

trol station eliminates cable tangle on the treatment room floor.

• Wired connection—the system can be instantly changed to a wired connection by connecting 
the cables. Either wireless detector Pods or wired detector Pods can be connected. Patient 
safety is preserved by using a medically-approved power supply. 

• Simple operation—push button energy selection makes daily operation simple.

• PIN protection—a user-furnished PIN number protects setup and calibration factors from 
accidental change.

• Redundancy—transceiver units are interchangeable and can be used in wireless or wired con-
figurations. Wired and wireless Pods can be used together in a wired configuration.

• Flexible mounting and connection—small size and flexible connections allow the system to 
be adapted to almost any treatment room.

Dose verification

The IVD Systems equipment verifies the actual dose administered to a patient. Typically, the sys-
tem is the final check of radiation administered as a part of an overall quality assurance system in 
a treatment facility.

Although errors due to planning, setup, calibration, and accelerator settings are extremely rare, 
they have occurred in the past, and it is reasonable to assume they could occur in the future. 

To use the system, the technician tapes one or more diodes to the patient’s skin in the area to be 
irradiated (Figure 1-4), then administers the treatment dose. Dose values are immediately dis-
played on the Control Module display or computer monitor, and a report can be printed. 

Figure 1-4. Taping a QED™ diode in place on the patient

For recommendations on the use this type of system for In Vivo Dosimetry, refer to AAPM Report 
87, “Diode in vivo dosimetry for patients receiving external beam radiation therapy,” ISBN 1-
888340-50-9, (2005), Radiation Therapy Committee, Task Group #62.

Total body irradiation (TBI)

You can also use the IVD systems equipment to verify dose administered to patients undergoing 
Total Body Irradiation. 
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With the Control Module, you can make up to 4 measurements simultaneously. The diodes can 
be positioned anywhere on the patient’s body. Using the Control Module can control one mea-
surement Pod with up to 4 diodes connected.

By using the IVD application software and up to seven detector Pods, you can make up to 28 mea-
surements simultaneously. The application software allows you to log data to transfer to 
spreadsheets, print a report with all 28 measurements showing, and print a report with multiple 
exposures on a single report. See “TBI measurements with multiple pods” on page 68.

Diode selection and use

You can use a variety of diodes with the system. Diodes should be selected for the beam energy 
range and the type of irradiation—photon or electron.

Each diode must be calibrated before use. Diode calibration factors are stored in non-volatile 
memory in the Pod for the specific channel for which the diode was calibrated. Once having con-
nected and calibrated a diode, you should leave it in that position. Each diode should be marked 
with a label to show where it was calibrated, and the Control Module should be similarly marked.

Sun Nuclear Corporation manufactures two types of diodes, the flat QED™ diodes and the omni-
directional IsoRad-III™ diode. Typical Sun Nuclear Diodes are listed in the table below.

Current Sun Nuclear Corporation diodes are fitted with LEMO coaxial connectors instead of BNC 
coaxial connectors. The LEMO connectors have smaller size and superior strength. You can still 
use other diodes having BNC connectors with Model 1136 or 1137 systems if you use the optional 
BNC to LEMO adaptor.

Table 1-1. Sun Nuclear diode detectors suitable for use with IVD Solutions

Type Model Application Output Color
QED 1114000-0 1-4 MV negative Blue

1114000-1 1-4 MV positive Blue

1115000-0 6-12 MV negative Gold

1115000-1 6-12 MV positive Gold

1116000-0 15-25 MV negative Red

1116000-1 15-25 MV positive Red

1112000-0 Electron negative Silver

1112000-1 Electron positive Silver

1113000-0 Skin negative Black

1113000-1 Skin positive Black

IsoRad-III 1162000-0 1-4 MV negative Blue

1162000-1 1-4 MV positive Blue

1163000-0 6-12 MV negative Gold

1163000-1 6-12 MV positive Gold

1164000-0 15-25 MV negative Red

1164000-1 15-25 MV positive Red
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Figure 1-5. Using the BNC to LEMO adaptor

Specifications

Table 1-2. Specifications for IVD solutions 

Category Characteristic Specification
Diode detector inputs Quantity Four channels; connection to 4 diodes

Connector type LEMO (BNC-LEMO adaptor available)

Detector temperature 
Compensation

Auto, within 0.1 °C (negative detector current only)

Calibration User calibrated against ion chamber standard

Repeatability ± 0.2% or ± 0.1 cGy

Detector requirements n or p type diodes responding between 5 to 100 nC/Gy

Polarity Bipolar, i.e., measures positive or negative detector current

Current limit ± 40 nA average radiation current or 1.0 nC per radiation 
pulse

Leakage Auto compensation

Warm-up time < 30 seconds

Environmental 
Temperature

15 °C to 32 °C 

Relative humidity 10% to 90% rh, non-condensing

Component defini-
tions, size and weight

Detector Pod Measure dose received by diode detectors, 4 diodes per 
Pod; 7x12x3 cm, 340 gm

Base station Data relay between wireless Detector Pod and Control Mod-
ule; 7x12x3 cm, 340 gm

Display Control Module with keypad for start and display of dosim-
etry measurements; 14x16x3.5 cm, 780 gm

Printer Seiko thermal printer, model DPU-414, serial port to display, 
9x320 dots/line, 40 column=9 cm; 16x17x6.6 cm, 580 gm 

Cable Control Module to base station (located in treatment room) 
via 6 pin modular connector/cable, 25 m.

Frequency 916.5 MHz for USA, 868.35 MHz for European Union

Power Detector Pod Rechargeable NiMH battery, 12 hour on full charge

Control Module Medically-approved power supply operating on 100-240 
VAC, 47-63 Hz mains, providing 18 VDC output

Electrical isolation • Wireless—through radio frequency communication, Am-
plifier Sequenced Hybrid (ASH), On-Off Keyed (OOK), 
Manchester encoded

• Hardwired—through medically approved power supply
Specifications 5



Control module Dose range 0 to 99.999 Gy; 0 to 9999.9 cGy; 0 to 9999.9 R

Display LCD, 2 line, 16 character/line, 8 mm character height, adjust-
able backlight and contrast

Functions Dose measurement, calibration of dose and temperature 
coefficient, PIN protection, self diagnostics

Measurement 2 key stroke, select energy key to start measuring, select 
STOP when finished.

Software Field updateable

Control buttons INCrement, PRINT, STOP, ENTER, MENU

Keypad 12 energy keys (also serve as numeric key entry)

Connectors • PRINTER PWR OUT: +18 VDC out to thermal printer (if 
power supply connected)

• +18VDC: Power input from medical power supply
• PRINTER: Serial data to thermal printer
• TO INST: Data and power connection to Pod
• COM: Serial data to/from PC
• USB: Universal serial bus data to/from PC

Pod Functions, rf • a) As detector Pod, measure detector current and trans-
mit data to the base station via rf communication

• b) As base station, relay data and commands between 
detector Pod and Control Module via wire

Functions, wired • Measure detector current and transmit data to Control 
Module

Software  Field updateable

End panel 1 • A, B, C, D: LEMO input connectors for diode detectors 
(BNC adapter available)

• DS1: Green LED – battery charge status
• DS2: Green LED – operational error status

End panel 2 • J5 and J6: 6-pin modular power/data connector
• a) to base station when used as detector Pod (For de-

tector Pod battery charging only)
• b) to detector Pod when used as Base Station (For de-

tector Pod battery charging only)
• c) to 2nd detector Pod when daisy chaining when not 

communicating by rf
• DC +15V: Power input, +9 to +20 VDC, barrel type con-

nector (For battery charging only)
• BAT 0-1: battery switch; 0=OFF, 1=ON, must be on in 

order to charge the battery
• DS3: green LED transmit status
• DS4: green LED receive status

RF transceiver 
specification

Frequency Fixed frequency; 916.5MHz, ± 0.2MHz for USA; 433.92 ± 
0.2MHz for European Union.

Power 94 dBuV/m. (0.1 milliwatt)

Modulation On/Off keyed.

Baud rate 4630 bits/sec.

Antenna 50 Ohm, ¼ wave, helical whip. Mounts via “reverse SMA” 
connector. 

Duty cycle approximately 20%

Encoding Manchester

Filtering SAW filtering in compliance with ETSI-ETS 300 220-1

Interference outside 
shielded treatment 
room

none

Table 1-2. Specifications for IVD solutions  (Continued)

Category Characteristic Specification
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How to use this guide

Table 1-3 summarizes the use of the various parts of this guide. The procedures are arranged 
sequentially. 

Windows Software 
Functions

Operating system Windows 95 and higher

Installation Installed with CD

START/STOP Start or stop data acquisition of profile.

RATE/DOSE Display profile scale in units of rate (cGy/sec) or accumu-
lated dose. Real time display (one update per second) 
allows instant feedback on machine adjustments.

Dose view • Calibrated setup “buttons”—provide 1-button operation. 
• Complete system status shown at all times.
• Dose values displayed on screen immediately after expo-

sure.
• Printed report with header data

Dose calibration view • Hierarchical list shows all data about setup. 
• Complete calibration steps shown on-screen.
• Complete report

Temperature calibration 
view

• Hierarchical list shows all data about setup.
• Complete temperature calibration steps shown on-

screen.

Table 1-2. Specifications for IVD solutions  (Continued)

Category Characteristic Specification

Table 1-3. Installation, setup, and operational procedures 

If you want to… Perform these steps: See Time* When
Install the system • Unpack and check the hard-

ware.
• Identify and learn about the 

components.

“Installation” on 
page 9

10 to 30 min. First time use

Connect a system • Connect a wireless system.
• Connect a wired system.

“Connections” 
on page 10

20 to 60 min. First time use

Install and operate the 
Control Module

• Install Control Module.
• Learn operation of module.

“Control module 
buttons and dis-
play” on page 14

10 to 120 min. First time use

Set up a system for use 
with Control Module

• Start up.
• Enter PIN, date and time.
• Set unit and system identifi-

cation numbers.

“Setup with con-
trol module” on 
page 18 

10 to 60 min. First time use

Calibrate a system with 
Control Module

• Calibrate beam energies.
• Correct diodes for tempera-

ture.

“Calibration with 
control module” 
on page 24

30 min. First time use

Make daily measure-
ments with Control 
Module

• Start up.
• Perform treatment.
• View dose.

“Control module 
operation” on 
page 17

1 min. Daily

Print reports with Con-
trol Module

• Select type of report.
• Print reports.

“Reports from 
control module” 
on page 34

1 min. As desired

Install and use PC 
software

• Install PC software.
• Learn operation of software.

“To install the 
software” on 
page 41

10 to 120 min. First time use

Set up a system for use 
with PC software

• Start up.
• Select serial port (if re-

quired).
• Enter PIN, date and time.

“Setup for PC 
software” on 
page 47 

10 to 60 min. First time use

Calibrate a system with 
PC software

• Calibrate beam energies.
• Correct diodes for tempera-

ture.

“Calibration with 
PC software” on 
page 59

30 min. First time use

Make daily measure-
ments with PC software

• Start up.
• Perform treatment.
• View dose.

“Measurements 
with PC soft-
ware” on 
page 65

1 min. Daily

Print reports with PC 
software

• Select type of report.
• Print reports.

“PC software 
reports” on 
page 68

1 min. As desired

*Estimated time to completion under average conditions.
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2 Installation

Unpacking

After unpacking, identify the parts and accessories in your system (Figure 2-1).

No. Part Number Description
Model Number
1136 1137

1 1136400 Control Module 1 1

2 1136300 Module, Pod/Base Station, wireless, Model 1136 rf-IVD2 2 -

3 1137300 Module, Pod, wired, Model 1137 IVD2 - 1

4 741008 Power supply, medical, 18 vdc, (black plug) 1 1

5 1133560 Cable, modular, phone, 6-conductor, 1 m (test cable) 1 1

6 1133550 Cable, modular, phone, 6-conductor, 25 m 1 1

7 801008 Cable, power, detachable, 6 ft, 125 V, 10 A 1 1 

8 801032 Cable, serial (RS-232), DB9M to DB9F, 6 ft (printer/computer) 1 1

9 801041 Cable, USB (universal serial bus), 2 m 1 1

10 850040 Printer, thermal, control module (includes 850043 paper roll) 1 1

11 1136030 Cable, power, thermal printer, 2.5 mm plug (red), 2.1 mm plug 
(black)

1 1

12 1133210 Wall bracket, transceiver charging 1 -

13 113149 Wall bracket, control module 1 1

14 781048 Adapter, LEMO diode to BNC Pod connector (optional) - -

15 781050 Adapter, BNC diode to LEMO Pod connector (optional) - -

16 023000 Compact disk, SNC software and manuals (not shown) 1 1

17 1136012 Getting Started booklet (not shown) 1 1

Figure 2-1. Parts and accessories for the IVD Solutions

1 2 4 5

6

8910

3

7

1112

13

14

15
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Connections

Types of connections

You have several choices for connecting the Model 1136/1137 IVD Solutions system:

• Control device—Control Module or PC. 

• Communication path—wireless or wired. The Model 1136 detector Pod can communicate via 
a wireless link or directly if connected to a cable.

The standard control device is the Control Module, although you can also use a personal computer 
(PC). Either control will work with the same Pods and cables, but there are differences in the 
connections. 

Figure 2-2 shows a typical wireless connection using a Control Module. System power connects 
to the power supply, which connects to the Control Module. The Control Module connects to the 
Base Station via a 25-meter cable that is routed through the cable conduit between the control 
room and the treatment room. The Base Station and Pod can operate on rechargeable batteries.

Figure 2-2. Typical wireless system connection with control module

Wireless connections 

In a normal wireless connection (Figure 2-3), you pull the 25-meter cable (P/N 1133550) through 
the conduit between the control room and the shielded treatment vault. One end of the long cable 
plugs into the Model 1136 base station which is placed in the charging wall bracket (P/N 1133210). 
The other end of the cable plugs into the Control Module. 

NOTE: Base station and pods are identical and interchangeable during setup.

The medical power supply (P/N 741008) connects to the Control Module and furnishes power for 
the Control Module, the printer, and the charging wall bracket. To apply power, plug the medical 
power supply into any wall outlet with 110 to 230 VAC, 50 to 60 Hz power. The power supply is 
auto-switching. 
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Figure 2-3. Wireless connection with control module

NOTE: To identify part numbers shown in connection diagrams, See Figure 2-1.

When the Pod is removed from the charging wall bracket for use, it operates on battery, providing 
patient isolation. After use, the battery is recharged in the wall bracket.

You can also connect a personal computer (Figure 2-4) to control the system. In this connection, 
the computer controls operation instead of the Control Module. You can connect to the computer 
via either a COM (serial) port or a USB port. 

While the PC is controlling the system, the Control Module's functions are locked out. The Control 
Module screen displays “System under PC Control. 30.” Pushing any buttons results in just a beep. 
The “30” (seconds) will start counting down (at one count per second) if the PC software is closed 
or disconnected. If the countdown reaches zero, the Control Module resumes stand-alone 
operation.

Figure 2-4. Wireless connection with PC

Wired connections

The normal wired connection (Figure 2-5) is identical to the wireless connection except that the 
diodes are connected directly to the Pod which is wired to the Control Module. You pull the 25-
meter cable (P/N 1133550) through the conduit between the control room and the shielded treat-
ment vault. One end of the long cable plugs into the Model 1137 Pod. The other end of the cable 
plugs into the Control Module. The Model 1137 Pod does not have a battery since it operates on 
cable power. The medical power supply provides patient isolation.
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Figure 2-5. Wired connection with control module

A wired connection with a computer (Figure 2-6) is almost the same as with the Control Module. 
You can connect to the computer’s COM (serial) or USB port.

Figure 2-6. Wired connection with PC

NOTE: Wired connections can also be used with a Model 1136 rf-IVD pod if one pod is damaged 
or the battery is discharged. 

Connections with multiple pods

Multiple Pods are only possible when using the PC software. If you use the Control Module, only 
a single Pod can be used.

For specialized measurements, you can connect up to 7 wired Pods in a single setup using the PC 
software. The Pods can be connected by connecting a 6-conductor cable, daisy-chained via the 
J5 and J6 ports (Figure 2-7). Since each Pod can accommodate 4 diodes, you can record up to 28 
measurements during a single exposure.

You can connect up to 13 wireless Pods in a single setup using the PC software. This allows up to 
52 measurements to made during a single exposure.
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Figure 2-7. Connections with multiple wired and wireless pods

Wall brackets

Two types of wall brackets are furnished: 

• The charging wall bracket (P/N 1133210) is mounted on the treatment room wall and contains 
powered mounting slots for the Base Station and the Detector Pod (Figure 2-8). DC power is 
supplied to the wall bracket. When the Pod is removed for daily use, it becomes battery pow-
ered. At the end of a patient session and at the end of the day, the Pod is returned to its slot 
in the wall bracket to be charged to full capacity overnight. 

• Attach the charging wall bracket to the treatment room wall with two suitable screws to 
fit the slotted holes in the back of the wall hanger.

• Feed the 6-conductor flat cable from the Control Module through the hole in the left side 
and connect to the Base Station.

• Place the Base Station on left side of the wall bracket. Charging power is provided via the 
6-conductor flat cable from the Control Module. 

• Place the Pod in the right side of the wall bracket. If desired, diode leads can be left 
attached to the Pod, and the diodes can be inserted in the slots on the front of the wall 
bracket.
Wall brackets 13



Figure 2-8. Wall bracket stores pod and diodes while charging battery

• If you are using multiple Pods, you can daisy-chain the wall brackets together (Figure 2-
9). The connector on the bottom right of the first fits into a receptacle on the bottom left 
to the next bracket.

Figure 2-9. Daisy-chaining wall brackets for multiple pods

• The Control Module wall bracket (P/N 113149) lets you mount the Control Module on the wall 
at the control station to allow more space on the desktop. The Control Module wall bracket 
is attached to the back of the Control Module with three, 6-32 x 3/16 pan head screws. To use 
the wall hanger, insert two suitable screws into the wall to fit the slotted holes in the back of 
the wall hanger.

Control module buttons and display

Control module front panel

The Control Module front panel (Figure 2-10) consists of a 2-line, 16-character liquid crystal display, 
Status LEDs, Function buttons, and Energy keys/keypad. The display shows measurements as 
well as abbreviated instructions to prompt you during special modes. 
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Figure 2-10. Control module front panel

Primary and alternate screens

The display consists of two types of screens: primary and alternate. The primary screen provides 
information or measurements for you; the alternate screens are hints or instructions that tell you 
what to do next. 

The primary screen appears when you select a menu item, initiate an action, or complete a mea-
surement. The alternate screen appears a few seconds later if you haven’t made an input or 
selected another activity. The alternate screen gives suggestions on what you should do next. If 
there is still no activity for a few seconds, the alternate screen switches back to the main screen. 
The two screens will switch back and forth until you take some action.

For example, 

• After the initialization, the Main screen appears. This Primary 
screen requests you to press an Energy key to start 
measuring:

• If you don’t press an energy key within a few seconds, an 
Alternate screen offers a suggestion:

LEDs
• READY—on when the system is ready to make a measurement. 

• AQRING—on during a measurement.

• LOW BAT—on if the Base Station or Pod battery is discharging and the running time for any 
of these units is less than 30 minutes.

Function buttons
• INC—increments through the displayed calibration factors.

• PRINT—sends data to the optional printer.

• STOP—stops an acquisition; enters spaces for numeric entry; cancels any of the menu 
modes.

• ENTER—accepts the action.

• MENU—displays a list of menu items.

Energy keys/keypad

Liquid Crystal Display

Status LEDs

Function Buttons

ENERGY  KEY  to   

Start  measuring  

MENU  for  more   

options          
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Energy buttons/keypad

These buttons are used for starting acquisition and entering numbers. The energy button’s LED is 
lit when its button has been calibrated. An energy button’s LED blinks when it is the active button 
while acquiring, or when there is a displayed measurement from a previous acquisition.

Each energy button has an alternate keypad number or entry arrow function associated with it.

When the cursor is blinking on a screen location, a numeric entry is expected at that location. 
Numeric entries are left justified. When the numeric key is pressed, the screen location updates 
with that entry, and the cursor location automatically advances to the next location. The STOP but-
ton will enter a blank.

The left and right arrow keys on the keypad can be used to move the cursor without a numeric 
entry. If the cursor is on the top line in a numeric entry location and the right cursor is pressed to 
the end of the numeric field, then the next press will advance to the first numeric location on the 
bottom line. Advancement will continue to the right until the last numeric field location and then 
jump back up to the top left.

Software installation

You can operate the system directly from your PC by installing special application software.

See “Software operation” on page 41.
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3 Control module operation

Planning to use IVD Solutions

Energy keys

The system is designed for one-button setup when using the Control Module:

• Tape the diode(s) to the patient

• Press a single “Energy Key” to select a setup and start collection

• Deliver the dose

• Press the Stop button to stop collection

• Read the measured dose on the display

• Print a report on the thermal printer

This sequence can be repeated over and over throughout the day’s treatments with minimal effort 
by the technician. 

The 12 “Energy Keys” on the front of the Control Module correspond to 12 memory locations in 
the connected Pod. Each key or memory location represents a stored setup, including energy, 
diode serial numbers, channels assigned, calibration values for each diode, and temperature cor-
rection factors. 

Examples of system setup

Before use, the physicist should decide what measurements are to be made, select and calibrate 
the appropriate diodes, store the setup and calibration data in the memory locations, and label the 
energy keys on the Control Module.

Example 1

The physicist decides to set up four single measurements for the normal energy types using a sin-
gle Pod. The physicist selects four QED diodes, connects them to channels A through D, enters 
the data into the Pod’s memory locations 1 through 4, and sets up buttons 1 through 4 as shown 
in the following table.

Example 2

The physicist wants another setup in which two diodes simultaneously measure entrance and exit 
dose in the 6-12 MV range. The physicist selects the gold QED diode which remains connected 
to channel B and replaces the channel D diode with a skin diode. Thus the new setup is as shown 
in the following table.

Table 3-1. Example setup of four diodes to be used singly for different ranges

Channel Diode Serial No. Energy Range Energy Key Technician Action
A QED 000021 1-4 MV (blue) 1 Tape blue diode to patient, press 1, adminis-

ter 1-4 MV photon dose, read value, print 
report. The other 3 diodes are not used.

B QED 000022 6-12 MV (gold) 2 Tape gold diode to patient, press 2, adminis-
ter 6-12 MV photon dose, read value, print 
report. The other 3 diodes are not used.

C QED 000023 15-25 MV (red) 3 Tape red diode to patient, press 3, adminis-
ter 15-25 MV photon dose, read value, print 
report. The other 3 diodes are not used.

D QED 000024 electron (silver) 4 Tape silver diode to patient, press 4, admin-
ister electron dose, read value, print report. 
The other 3 diodes are not used.
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In the above example, the physicist can simply transfer the calibration for gold diode 000022 to 
memory location 5, but the skin diode, 000025, must be newly calibrated for this setup. The data 
for both diodes is stored in memory location 5. To shift from example 1 to this setup, the techni-
cian must know that electron diode must be removed from channel D and the scatter diode 
installed in its place. There are no copy or edit functions for calibration factors in the Control Mod-
ule. There is only recalibration.

Setup with control module

Initializing
1 Connect cables and power as described in Section 2. See “Connections” on page 10.

CAUTION: To obtain a valid background measurement, the diodes must be connected to the detector Pod 
before applying power to the Control Module.

2 Connect the correct diodes to the Detector Pod. (They can remain connected.)

• The same diodes used for calibration must be connected to the same terminals that were 
used during calibration.

• Diodes must be connected before powering the Control Module to get a valid back-
ground measurement.

3 Verify that the correct Pod is connected. 

• Calibration factors are stored in the Pod’s memory.

4 Apply power to the Control Module. When power is applied 
to the Control Module, the display powers up and shows the 
“Initializing” message.

• Then the system looks for system components and dis-
plays “Finding Pod #NN,” the last-used Pod number. 

• If a different Pod is found, the message “Found Pod #NN” is displayed. This means that 
the Pod being sought is switched off or the connection has changed. If you have deliber-
ately changed connections and want to use a different Pod, press ENTER to select the 
new Pod. See “System select” on page 20.

5 If all the hardware for this system is found, the Background 
collection screen appears. 

• This is the initial background collection screen before 
data acquisition.

• Background measurement takes about 20 seconds. Dur-
ing this time the alternate screen displays “Please wait” 
and numbers in the lower right hand corner count down 
from 20.

6 The Control Module displays the “Main screen.” After initialization, the Control Module can 
be left on indefinitely. There is no ON/Off switch.

7 If you are using an rf-IVD2 system, perform a battery check (see “Battery check” on page 20). 
If the battery check shows B=N/A, you have set the system up as a wired system. See Figure 
2-3 or Figure 2-4.

Table 3-2. Example setup of two diodes to be used in combination

Channel Diode Serial No. Energy Range Energy Key Technician Action
B QED 000022 6-12 MV (gold) 5 Tape gold diode to top surface of patient, 

tape black diode (000025) beneath patient 
press energy key 5, administer dose, read 
values, print report.

D QED 000025 scatter (black)

Initializing

|||||||||||    

Measuring       

BACKGROUND... 20

Please  wait     

              15
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“Main” screen

Once the initialization, system check, and background acquisition are complete, the “Main screen” 
will be displayed.

• With this message displayed, the system is ready to make a 
measurement. The energy keys that have calibration values 
for connected detectors will have their corresponding LEDs 
lighted. 

• Once an acquisition has been completed, the Main screen will be displayed while background 
collection is done.

• The alternate screen for the Main screen reminds you that 
more options are available by pressing the MENU button.

When the Main screen is displayed, the system is ready for a measurement. 

After the first measurement, the Main screen shows the results 
of the last measurement taken. 

Menu functions

Menu items below are used for system setup and calibration.

NOTE: Once you have opened the menu, you can use the arrow keys to scroll through the menu.

Menu operation

The menu is accessible from the Main screen when acquisition is not going on. Each menu item 
has a normal screen. 

1 Press MENU button. The first menu item appears. 

2 After a few seconds, the alternate screen appears.

3 Continue pressing MENU button (or press the arrow keys) to 
scroll through the menu items.

4 At any time while stepping through the menu, the STOP button can be used to leave the menu 
and return to the Main screen.

ENERGY  KEY  to  

Start  measuring  

MENU  for  more   

options          

A=99.8  B=102.1

C=98.4   D=99.6  

Table 3-3. Control module menu functions 

Menu Item What it does Comments Page
Battery Check Shows battery charge for all units 20

System Select Selects the Pod number 20

Display Adjust Controls brightness and contrast 21

Time and Date Sets time and date 21

Software Version Displays software version for each unit in 
system

21

Dose Calibration Sets calibration for an energy button PIN required 22

View Calibration Displays calibration results for an energy 
button

PIN required 22

Temperature Coef Determines temperature correction coefficient PIN required 22

Dose Unit Setup Selects dose unit for display 22

Device ID Setup Sets ID number for each unit PIN required 22

PIN Setup Enters or changes PIN PIN required 23

Physics Mode Switches to Physics Mode for testing, calibra-
tion, or setup

PIN required 23

Institution Name Sets optional institution name to be printed on 
reports

24

Press MENU  for  

next  item        
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Initial settings 

For first-time use, select the preferences you want from the menu:

1 If you want to enter an administrator PIN (personal identification number) see “PIN setup” on 
page 23. Using a PIN forces you to enter the PIN prior to making important settings. This pre-
vents accidental or inadvertent changes when several people are using the system. If you 
don’t want to use a PIN, do not enter a PIN initially, or if there is already a PIN, change the 
existing PIN to 0000.

2 To adjust the display brightness and contrast, see “Display adjust” on page 21.

3 To check and change the time and date, see “Time and date” on page 21.

4 The default dose unit for display is cGy. To change to Gy or Rad, see “Dose unit setup” on 
page 22.

5 Each unit is assigned a number. To change a device ID, see “Device ID setup” on page 22.

6 You can enter an optional Institution Name to be printed at the top of each printed report. See 
“Institution name” on page 24.

Battery check

This menu item is used to check the remaining battery life and the state of each battery (Model 
1136 only). Administrator pin is not needed.

NOTE: Battery check shows “predicted” battery life, which may differ from actual battery life. See 
“About predicted battery life” on page 87.

1 Press MENU button. The first menu item appears, which is 
“Battery Check.”

2 Press ENTER. The status of each battery is shown.

• Unit Name. 

• Bar scale shows the measurement time left. A full bar 
scale is equivalent to 10 to 12 hours of normal operation, 
enough to complete an 8-hour shift.

• Status: chg=charging (battery is discharged and is 
charging at maximum rate), trc=trickle charging (a full charge is being maintained with a 
trickle of power), dch=discharging, off= battery switch is off, ???????=unit not found, N/
A=system selected has no base station. If a base station is desired, change system 
select.

• A battery can show “off” when fully charged.

• “N/A” means that the wireless system selected has no base station or has the wrong Pod 
selected in the System Select. See “System select” below.

3 Press STOP to exit and return to Main screen.

System select

This menu item selects the present configuration by selecting a unit and designating it as the Pod. 
This ensures that all the correct units are connected and communicating, and that the correct cal-
ibration factors (stored in the Pod) are used. Administrator PIN is not needed.

1 Press MENU button. The first menu item appears.

2 Continue pressing MENU button until “System Select” 
screen appears. 

3 Press ENTER.

4 The current Pod identification number is shown. Use the 
arrow keys to increment or decrement the Pod identification 
(ID) number.

• Each Pod is assigned a unique number from 02 to 15. 

Battery  Check   

Press  ENTER      

Base: |||||| chg

Pod: |||| dch

System  Select   

Press  ENTER      

Use ARROWS to

select Pod ID=02
20 Section 3. Control module operation



• A wired system (model 1137) has one or more measurement Pods. If a wireless system 
(model 1136) is being used, a Base Station is also required. 

5 Press ENTER to confirm and save the Pod number or STOP 
to abort.

• Accepting a new number causes the system to re-initial-
ize with the new Pod number.

• STOP returns to Main screen.

Display adjust

This menu item is used to adjust the brightness and contrast of the screen. Administrator pin is 
not needed.

1 Press MENU button. The first menu item appears.

2 Continue pressing MENU button until “Display Adjust” screen appears.

3 Press ENTER. Then press the arrow keys on the keypad to 
adjust the screen brightness. Continue pressing arrow keys 
until the brightness is at the desired level.

4 Press ENTER to save the selected level of brightness and 
continue to the contrast screen.

5 Use the arrows to select the desired contrast. Continue 
pressing to increase or decrease the contrast.

6 Press ENTER to select the contrast and exit this menu item. 
The display returns to the Main screen.

Time and date

This menu item is used to set the display's internal clock. Administrator pin is not needed.

1 Press MENU button. The first menu item appears.

2 Continue pressing MENU button until “Time and Date” 
screen appears.

3 Press ENTER. The display shows the current time as hours: 
minutes: seconds and the date as day/month/year.

• A cursor bar appears under the character to be changed. 

• Use arrow keys to move cursor around.

• Use number keys to enter the time in HHMMSS format 
(hours, minutes, seconds) and date as DDMMYY (day, 
month, year).

• When a digit is changed, the change is written to the 
internal clock.

4 Press ENTER to leave the menu item, and return to the Main screen.

Software version

This menu item is used to display the embedded firmware versions of all the units. Administrator 
pin is not needed. 

You may need to check the software version when speaking to Sun Nuclear Corporation Technical 
Support and to check that the Base Station and Pod have the same version.

1 Press MENU button. The first menu item appears.

2 Continue pressing MENU button until “Software Version” 
screen appears.

3 Press ENTER. The software versions appear on the display. Units are identified by letters:

ENTER=  Accept  

STOP  =  Exit     

Use  < > to   

set  brightness   

Use  < > to    

set  contrast   

Time  and  Date   

Press  ENTER      

HHMMSS: 15:27:59

DDMMYY: 18/04/05

Software  Version

Press  ENTER      
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D=Display; B=Base Station; P=Pod

4 Press ENTER or STOP to return to the Main screen.

NOTE: Base and Pod software versions should be the same.

Dose calibration

This menu item is described in the calibration procedure. See “Dose calibration” on page 24.

View calibration

This menu item is described in the calibration procedure. See “View calibration” on page 26.

Temperature coef

This menu item is described in the calibration procedure. See “Temperature coefficient (Tc)” on 
page 27.

Dose unit setup

This menu item is used to select the dose units that are displayed and printed. Administrator PIN 
is not needed.

1 Press MENU button. 

2 Continue pressing MENU button until the “Dose Unit” screen 
appears.

3 Press ENTER button. 

4 Press the arrow keys to cycle through the list of units. 

• Units are cGy (centigray), Gy (gray), Rads (rad).

5 Press ENTER button to confirm or STOP button to abort the 
change. 

6 An alternate screen prompts this change.

7 At any time during the process:

• Pushing the ENTER button selects that unit of measure-
ment, leaves the menu item, and goes back to the Main screen.

• Pushing the STOP button leaves this menu item and goes back to the Main screen.

Device ID setup

Device ID numbers are assigned at the factory. You can use this menu item to change the Identi-
fication code (ID) of a Pod. Normally they will not be changed throughout their life. However, if you 
happen to purchase additional Pods, exchange Pods from another treatment room, or are using 
Pods from two different systems, you may need to change a device ID number to prevent having 
duplicate numbers. Administrator pin is needed.

1 Press MENU button. The first menu item appears.

2 Continue pressing MENU button until “Device ID Edit” 
screen appears.

3 Press ENTER.

4 Key in the 4-digit Administrator PIN number, and press ENTER.

5 Use the arrow keys to increment or decrement the ID num-
ber or use number keys to enter the ID.

• The ID that is displayed will be the current ID.

• The ID is a number from 02-15.

6 Press ENTER button to select the new ID or STOP to keep 
the old ID.

• After changing the Pod’s ID, you will be prompted to 
Select system. See “System select” on page 20. After 
selecting the new Pod, the system will re-initialize.

D=10200  B=10000  

P=10000

Dose  Unit       

Press  ENTER      

< > select dose

unit: cGy    

ENTER=  Confirm  

STOP  =  Abort     

Device  ID  Setup

Press  ENTER      

< > Change ID:02

ENTER = Confirm

STOP = Abort     
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• If the Pod number is unchanged or STOP is pressed, the display returns to the Main 
screen.

PIN setup

This menu item is used to set up a PIN (Personal Identification Number). The administrator PIN 
avoids accidental changes to setup and calibration. Default for the “Pin Setup” screen is 0000, 
which is No PIN. 

1 Press MENU button. The first menu item appears.

2 Continue pressing MENU button until “PIN Setup” screen appears.

3 Press ENTER.

4 Key in the 4-digit Administrator PIN number, and press 
ENTER. If no PIN is set, enter 0000. 

NOTE: If the PIN is lost or forgotten, the physicist can key in “911” 
to display the stored PIN. After 911 is entered, fill in the stored PIN 
and press ENTER to continue. Then the existing PIN can be used, or the PIN can be changed.

5 The “Key in new PIN #” screen appears.

6 Use the number keys to enter a 4-digit PIN. When entering 
the numbers:

• The arrow keys can be used to scroll left or right.

• The un-initialized value is all 0’s and is invalid for a PIN.

• All 4 digits must be used. 

• To remove a PIN, enter four zeros when prompted.

7 Press ENTER to confirm or STOP to abort without change. 
The display returns to the Main screen.

Physics mode

Physics Mode is a special mode for the physicist to test and calibrate equipment. Administrator 
pin is needed. Physics Mode allows the physicist to set up a variety of configurations for testing 
and calibration. 

To use Physics Mode:

1 Press MENU button. The first menu item appears.

2 Continue pressing MENU button until “Physics Mode” 
screen appears.

3 Press ENTER.

4 Key in the 4-digit Administrator PIN number, and press ENTER. 

5 Pressing the ENTER button turns ON Physics Mode and 
momentarily displays the message “Physics mode is now 
on.”

• The display returns to the Main screen in Physics Mode.

• If the system is powered down while in the Physics Mode, it will automatically switch 
back to normal mode when powered up again.

• If the Physics Mode is inactive for 1 hour, the system will automatically revert back to 
standard mode. 

NOTE: When Physics Mode is active, the letter 'P' appears in the 
lower right hand corner of the dose display.

6 Pressing STOP turns the Physics mode OFF and momen-
tarily displays the message “Physics mode is now off.”

• To turn off Physics mode, press MENU, scroll to Physics Mode, enter PIN, and press 
STOP; or, power down the system.

Key in pin#____

then ENTER

Key in new PIN #

9999 Then ENTER

ENTER=  Confirm

STOP = Abort     

Physics  Mode    

Press  ENTER      

ENTER=  Mode  ON  

STOP  =  Mode  OFF  

A=9.9  B=9.9

C=9.9    cGy     P
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Institution name

An optional Institutional name can be entered via the menu that will appear at the top of every 
printed report. The Institution name can be a maximum of 32 characters and will be centered on 
the top text line of each printed report. Administrator PIN is not needed.

1 Press MENU button. The first menu item appears.

2 Continue pressing MENU button until “Institution Name” 
appears.

3 Press ENTER to continue. A blank screen appears. The cur-
sor appears in the upper left space on the screen. 

4 To enter the first character, press the INC key to scroll through a list of characters. Available 
characters are 0-9, A-Z,. :, &. 

5 To move the cursor, press the arrow keys.

6 When finished entering the institution name, press ENTER to accept or STOP to abort.

Calibration with control module

Calibration overview

Before using the IVD, you must calibrate the system for beam energies and temperature response 
(negative diodes only). Both of these calibration factors are stored in non-volatile memory in the 
Detector Pod on which the calibration was performed.

Beam energy calibration is assigned to a specific button; temperature correction factor is 
assigned to all buttons using the diode serial number and exposure parameters to which the tem-
perature correction factor applies.

In daily operation, pressing a single calibrated energy button prepares the system for measure-
ment. One-button operation simplifies the therapist’s daily work. 

To standardize setup and prevent mistakes in operation, the physicist should consider the follow-
ing suggestions:

• Select one of the connection methods appropriate to your needs and stick with it.

• Mark each Pod and Base Station with its unit number. Remember, correction factors are 
stored in each Pod, not the Control Module. 

• Place an adhesive label next to each energy button calibrated, and mark the parameters to 
which the button was calibrated.

• If you have multiple Pods, use a consistent method for assigning buttons to beam energies. 
Example: button 1=6 Mev, button 2=18 Mev, etc. on all Pods.

• Use consistent placement of diodes on Pod connectors A, B, C, and D.

Dose calibration

This menu item is used to complete dose calibration on a per-button basis. Administrator pin is 
needed.

1 Press MENU button. The first menu item appears.

2 Continue pressing MENU button until “Dose Calibration” 
screen appears.

3 Press ENTER.

4 Key in the 4-digit Administrator PIN number, and press ENTER.

5 Fill in the blank spaces in front of either “Xray” or “Electron” 
with the value of the beam energy you will use during 
calibration. 

• Only one field may contain a numeric entry. If you 
attempt to enter numbers for both X-ray and Electron, an error message appears.

Institution Name

Press  ENTER      

Dose  Calibration

Press  ENTER      

Key in MV or MeV

__Xray__Electron
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• If a numeric entry starts in the other field, clear the old field by entering zeros in it. 

6 After keying in the beam energy, press ENTER. 

7 Key in the serial numbers (s/n’s) of the detectors connected 
to the A, B, C, and D connectors (type over the “s/n” 
characters). 

• To edit a serial number after entry, move the cursor 
(using the arrow keys) to the required location and key in the appropriate numeric value. 
Example: If a number such as 1376027 is to be replaced with a number 3487, then start 
at the left cursor position and enter 0 0 0 3 4 8 7. 

• Serial numbers will be from 1 to 9999999. 

• No spaces are allowed.

• If no serial number is entered, the serial number will be saved as 0.

• Duplicate serial numbers on multiple channels are not 
allowed.

• Serial numbers are left justified.

• If intermediate blanks occur in a serial number or if two channels have the same serial 
number when ENTER is pressed, the system will assume that the serial numbers are 
invalid.

• The serial number can be cleared by entering 0 for all digits.

8 Press ENTER.

9 Set up the machine to deliver the specified dose that you wish to calibrate.

10 Press the energy key which is to be calibrated.

• The LED is out for un-calibrated energy keys. The LED is 
on if a key has already been calibrated. 

• If you select a key that was previously calibrated, the 
new calibration will overwrite the old calibration.

• An alternate screen may appear with additional 
instructions.

11 After the energy key has been pressed, its corresponding 
LED blinks, the AQRING LED turns on, and the message 
“Starting...” is briefly displayed.

12 Counts are displayed for connected diodes. 

13 Within a few seconds, the alternate screen will instruct you 
to “Turn on beam.”

14 Turn beam on. The alternate screen will change to “Measuring, please wait.”

15 The primary screen will show the changing counts. 

• Counts are background-compensated just as in a typical dose measurement. 

• Both negative and positive numbers can be displayed. 

• A lower case channel letter will be used and a ‘~’ will be displayed in the ‘=’ sign position 
to let you know when a bad background was collected. i.e. accelerator was on, or exces-
sive leakage. 

16 When the beam turns off, press STOP. 

• The message “Stop when done” will display when the beam turns off.

• The message “Stopping...” will briefly appear.

• The number of counts will be shown.

• The measurement Pod will automatically detect when the beam turns off and will make 
a temperature measurement (negative output diodes only). 

17 After Stop is pressed, key in the dose delivered. 

A s/n B s/n

C s/n D s/n

Error, duplicate

s/n‘s not valid

Press ENERGY KEY

to start

Select key  for

CALIBRATION

A± B±

C± D±

Key in dose

0000.00 cGy
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• Use keypad to enter numbers, arrows to move cursor. Typical entries will be in hundreds 
of cGy, example: 100.0 cGy

• Units can be changed to either cGy, Gy, or Rad in the “Dose Unit” menu item. If the units 
are changed after calibration, the display will compensate with the decimal shift in Gy (1 
Rad = 1 cGy, 1 Gy = 100 cGy).

18 After the dose value has been keyed in and ENTER pressed, 
the first calibration factor will be shown.

• A, B, C=diode terminal; Cf = the calculated calibration 
factor; Sn=serial number of diode

• The Calibration Factors will always be less than 1. 

• The Cf can be positive or negative, depending upon the sign of the measured current.

• Calibration factors are stored in the Pod, not Display. Each Pod contains its unique cali-
bration factors. 

19 Press INC to scroll, in a continuous loop, through the calibra-
tion factors for A, B, C, and D.

20 Pressing PRINT will print a report for this calibration. For 
printout details, see “Dose calibration report” on page 75.

21 Press ENTER to save the calibration or press STOP to abort.

• Pressing ENTER saves the calibration factors to the measurement Pod, displays the brief 
message “Saving...,” leaves the calibration menu item, and returns to the Main screen.

• Pressing STOP exits the procedure without saving the calibration factors and returns the 
display to the Main screen.

CAUTION: Validate after calibration!

22 Immediately after calibration, the diode calibration should be validated at the same reference 
conditions used during calibration. This measurement should be performed in the same man-
ner as will be used for patient dosimetry. (See “Control module operation” on page 17.) These 
results should be recorded for future reference and repeated at least monthly for trend 
analysis.

View calibration

This menu item is used to display, print, and delete the calibration factors for the selected button. 
Administrator pin is needed.

To view calibration

1 Press MENU button. The first menu item appears.

2 Continue pressing MENU button until “View Calibration” 
screen appears.

3 Press ENTER.

4 Key in the 4-digit administrator PIN number, and press ENTER.

5 A new screen appears. Press the energy key whose calibra-
tion you want to view.

• The LED for the energy button being reviewed will blink.

6 The first calibration factor (diode A) appears along with the 
diode serial number and beam energy for the calibration.

7 Press INC to scroll to the other diodes.

• Continue Pressing INC to scroll through the calibration 
factors in a continuous loop. 

• Press ENTER to go back to “Energy key to select Cal” 
screen and select another button to review.

• Press STOP to exit. 

A  Cf=-0.9999999  

Sn=9999999  99MeV

INC=Scroll  ENTER

=Save  STOP=Abort

View  Calibration

Press  ENTER      

ENERGY  KEY  to  

select  Cal       

A  Cf=-0.9999999  

Sn=9999999  99MeV

INC=Scroll  ENTER

=More  STOP=Abort
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Print calibration

8 Press PRINT to print out a report for this calibration. For printout details, see “Reports from 
control module” on page 34.

Delete calibration

9 To delete the button’s calibration factors, press both arrow keys at the same time. 

10 Verify you want to clear the calibration factor that is being 
reviewed.

• If the ENTER is pressed, the message “Deleting...” will 
be briefly displayed, the calibration factors for the button 
will be permanently deleted, and the LED will turn off.

• If STOP is pressed, the calibration factors will not be deleted.

11 Display returns to the “ENERGY KEY to select cal” screen. Press another button to view 
another calibration or press STOP to return to the Main screen.

Temperature coefficient (Tc)

The dose response of diodes varies with changes in temperature. The “Temperature coefficient” 
(Tc) is the fractional change in response per unit of junction voltage across the diode. The junction 
voltage varies inversely with the temperature, and is measured with a 12-bit analog-to-digital con-
verter. For most diodes, a change of approximately 10 analog-to-digital units is equivalent to a 
change of 1 degree Celsius.

In models 1136 and 1137, you must determine your own temperature coefficient by either: 

• Using a lookup table and entering a value (see below)

• Measuring temperature coefficient (see “Temperature coefficient measurement” on page 28)

Temperature coefficient table

The temperature coefficient table provides reasonably accurate temperature coefficients based 
on the model number, serial number, and manufacturer of the diode you are using.

NOTE: For detectors not manufactured by Sun Nuclear Corp., the data may not be updated. Please 
contact the manufacturer for the updated information.

To enter Tc and V’ from table
1 Press MENU button. The first item appears.

2 Continue pressing MENU button until “Temperature Coef” screen appears.

3 Press ENTER.

4 Key in the 4-digit administrator PIN number, and press ENTER.

Delete  Cal?     

ENTER=Y  STOP=N   

Table 3-4. Nominal temperature coefficients of commercial diode detectors 

Detector name Manufacturer Temperature coefficient
(%/°C)

V'
(mV/°C)

Isorad Sun Nuclear 0.3 ± 0.1 -2.2 ± 0.1

Isorad-p 

QED (p-type) (S/N below 3323601)
Sun Nuclear 0.3 ± 0.1

-2.4 ± 0.1

Isorad-III Sun Nuclear 0.5 ± 0.1 -2.1 ± 0.1

QED (n-type) (S/N 3323601 and 
up)

Sun Nuclear 0.6 ± 0.1 -2.0 ± 0.1

Hi-pSi Scanditronix 0.4 N/A

3G-pSi Scanditronix 0.25 -2.0 ± 0.1

Veridose Nuclear Associates 0.5 N/A

In-vivo Semi-Conductor probes PTW 0.15 N/A
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5 Enter the serial numbers (s/n’s) of the detectors connected 
to the A, B, C, and D connectors and press ENTER. The dis-
play shows “Please wait...” 

6 Select the energy keys on which these serial numbers are 
calibrated and press ENTER. 

• This assigns temperature coefficients to the detectors with the same serial numbers cal-
ibrated for these keys.

• Only keys calibrated with these serial number diodes will be lighted.

• When selected, the LEDs will blink.

7 Select the data source for the temperature coefficient as 
“Table” by pressing the arrow keys.

8 Press ENTER.

9 Key in the value(s) for V’ from Table 3-4 for the diode serial 
numbers you previously entered, and press ENTER. 

10 Key in the values of Tc from Table 3-4 for the diode serial 
numbers you entered, and press ENTER. The screen shows 
“Saving...” then returns to the Main screen.

NOTE: You can check that you entered the correct values with the 
“View Calibration” menu item.

Temperature coefficient measurement

If you want to determine temperature coefficients experimentally, you can do so using the follow-
ing procedure.

Preparation

This procedure is used to perform temperature coefficient measurement for a Detector Pod and 
diode combination. Administrator pin is needed.

NOTE: Only negative diodes can be measured for a temperature coefficient.

To perform this procedure, you will need the following additional equipment:

• standard microwave oven

• a small water-filled bag, such as a locking sandwich or freezer bag

It is assumed that treatment room ambient temperature is about 22 °C (72 °F) and that the water 
bag will be heated in the microwave oven to about 38 °C (100 °F). First, a measurement is taken 
at ambient temperature. Then the bag is heated and placed over the diodes and another measure-
ment is taken. The temperature coefficient is calculated from the two measurements.

For calculation details, see “Calculations” on page 77.

Application of temperature coefficients

A calculated temperature coefficient only applies to a single diode serial number. The same tem-
perature coefficient can be applied wherever that same diode serial number is used, as long as 
the instantaneous dose rate is within an order of magnitude. (Some diodes have been found to 
have a different temperature coefficient with Co-60 beams than with accelerator beams.)

Generally, a group of diodes from the same manufacturing lot will have nearly the same tempera-
ture coefficient, but for best results, it is better to determine the temperature coefficient for each 
diode. 

In accelerator beams, the instantaneous dose rate within the pulse of radiation is on the order of 
10,000 cGy/s. In Co-60 beams, the instantaneous dose rate is on the order of 5 cGy/s. So, even 
though both beams have an average dose rates of about 300 cGy/min, there can be a significant 
difference in the temperature coefficient for a diode in these two beams. 

A s/n B s/n

C s/n D s/n

Select Data

Source:Table <>

AV'=-0.0BV'=-0.0

CV'=-0.0DV'=-0.0

Atc= 0.0Btc= 0.0

Ctc= 0.0Dtc= 0.0
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In TBI beams where the SSD is 300 to 400 cm, the instantaneous dose rate will be 1/10 of that at 
100 cm. Here also, it may be advisable to remeasure the temperature coefficient for TBI applica-
tions. In different beam energies, the instantaneous dose rate within a pulse is typically within a 
factor of 2 or 3 and should not contribute to measurable changes of temperature coefficient.

Temperature coefficient measurement example

For example, a physicist has a 6 MV diode (SN 666), an 18 MV diode (SN 1818) and an electron 
diode (SN 5555). The physicist has calibrated for 5 procedures: 6 MV on button 1, 15 MV on button 
2, 6 MeV on button 3, 9 MeV on button 4, and 12 MeV on button 5. All these are at 100 cm SSD. 

The physicist wishes to do temperature compensation for all three diodes. The physicist would 
choose to do one Temperature Coefficient Measurement at 6 MV, using diode SN 666, then 
another one at 15 MV, using diode SN 1818, and finally, another one for all three electron energies 
using diode SN 5555. The electron Temperature Coefficient Measurement can be measured using 
any one of the electron energies (the physicist chooses, say, 9 MeV) and all three electron energy 
buttons are selected on step 7 of the Temperature Coefficient Measurement procedure. 

Once all the Temperature Coefficients are entered, the physicist then verifies that they are correct 
for all energies by taking a measurement at room temperature, and then another measurement 
after two minutes under a hot heat pack. If the measurements are within 1-2%, then the coeffi-
cient is correct. If however, the measurements do not agree for a particular energy, then the 
physicist can perform the Temperature Measurement coefficient procedure for that energy.

Temperature coefficient measurement procedure

1 Tape a thermometer and the diodes on a room-temperature, 3 cm thick, acrylic phantom (Fig-
ure 3-1). The phantom provides a thermal mass during the test. 

2 Place the water bag over the diodes and the thermometer. The diodes should be under the 
bag during exposure and measurement.

3 Press MENU button. The first menu item appears.

4 Continue pressing MENU button until “Temperature Coef” 
screen appears.

5 Press ENTER.

6 Key in the administrator PIN number and press ENTER.

Temperature  Coef

Press  ENTER      
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Figure 3-1. Place cool water bag over diodes prior to exposure

7 Key in the serial numbers of the detectors which will have 
their temperature coefficient measured. 

• The combination of a detector serial number and a con-
nector (A,B,C,D) must match at least one of the 
combinations in the Energy Key calibration table. 

• Once the detector serial numbers are keyed in, the LEDs for all energy buttons will go off 
unless they have calibrations using these same serial numbers.

• The detectors do not need to be the same energy.

• The detectors do not need to co-exist on the same Energy Key.

• All detectors can be tested for temperature coefficient in the same beam, as long as the 
dose per pulse (or instantaneous dose rate) is nominally within one order of magnitude 
of their intended beam use. 

• To change a serial number, move the cursor to the required location and key in the correct 
numeric value.

8 After the serial numbers are entered, press ENTER. 

• The message “Please wait...” appears while the system looks for energy keys calibrated 
with the selected diode serial numbers. The LEDs for all other energy keys go out. LEDs 
for keys using the selected diode numbers remain lighted.

• A screen appears that instructs you to press the energy 
keys for which the temperature coefficients will be mea-
sured and then assigned to.

• The alternate screen describes the purpose of the 
selection.

9 Press keys to select for storage of measured temperature 
coefficients; the LEDs will begin flashing.

10 Press ENTER. 

A s/n B s/n

C s/n D s/n

Select Energy

Keys, then ENTER

Assigns tmp coef

to  keys     
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11 Select the data source for the temperature coefficient as 
“Measure” by pressing the arrow keys and Press ENTER.

12 Make a heat pack (water-filled sandwich or freezer bag) by 
filling the bag with cold (ambient temperature) water 
(approximate temperature 22 °C (72 °F). Remove any large air bubbles. 

13 Place the cold water bag over the diodes (Figure 3-1).

14 Press ENTER to continue.

15 Wait for 7 minutes to allow the temperature of the diodes 
and the phantom to stabilize.

• The display will count down and show the remaining 
minutes.

• When the 7 minutes has elapsed, the display will beep and a temperature entry screen 
appears.

16 Read the thermometer and key in the temperature that you 
read on the thermometer.

17 Press ENTER to continue. The message “Starting...” appears briefly. The alt-screen displays 
“Deliver dose at desired energy.”

18 Turn on the beam and deliver 100 MU dose to the diodes. 
During exposure, the screen will display “Measuring, please 
wait.”

19 When the beam turns off, press STOP.

20 The alternate screen shows the diode junction voltage 
measurement. 

21 Place the water bag in a microwave oven and turn on the 
oven for about 40 seconds. The heat pack should heat up to 
approximately normal body temperature of about 38 °C (100 °F), warm to the touch.

22 Place the hot water bag over the diodes (Figure 3-1).

23 Press ENTER to continue.

24 Wait for 7 minutes to allow the diodes and the phantom to 
stabilize.

• The display will count down and show the remaining 
minutes.

• When the 7 minutes has elapsed, the display will beep and a temperature entry screen 
appears.

25 Read the thermometer and key in the temperature that you 
read on the thermometer.

26 Press ENTER to continue. 

27 Turn on the beam and deliver 100 MU dose to the diodes. 
During exposure, the screen will display “Measuring, please 
wait.”

28 The alternate screen shows the measured dose in counts. 

29 When the beam turns off, press STOP.

Select Data

Source:Measure<>

Apply cold bag

to diodes

Please Wait 7

Minute(s).

Enter meas temp

__._ °C

Measuring,

please wait

A=9999 B=9999

C=9999 D=9999

Apply hot bag

to diodes

Please wait 7

minutes.

Enter meas temp

__._ °C

Measuring,

please wait

A=9999 B=9999

C=9999 D=9999
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30 After the two exposures described above are recorded, the 
display unit will calculate the temperature coefficients and 
display them.

• Press the INC button to scroll through the inputs in a 
continuous circle.

• Typical temperature coefficient values will be negative 
and have an approximate value of –0.0004 ±0.0002. See 
Note after step 29. 

• Pressing ENTER will save the temperature coefficients to the measurement Pod and exit 
the Tc function.

• Pressing STOP will exit the calibration function without saving the calibration factors.

• For calculation details, see “Calculations” on page 77.

31 To print the temperature coefficients, print a dose calibration report. The Dose Calibration will 
print on the optional printer, showing the temperature coefficients for the diodes. See “Dose 
calibration report” on page 39.

NOTE: The displayed temperature coefficients are in terms of fractional response change to a junc-
tion voltage change of the diode. The junction voltage is a linear function of temperature (percent 
per degree C). 

32 Validate the application of the temperature coefficients as follows:

a. Position detectors on room temperature buildup and make a measurement under cali-
brated conditions. This result should be reasonably accurate.

b. After that measurement, place the warmed water bag on the detector for about 2 min-
utes, remove the bag, and repeat the measurement.

c. The second measurement should agree with the first room temperature measurement 
within 1 or 2 percent.

Measurements with control module

Daily preparation (Model 1136)
1 Allow the batteries to charge overnight. This will ensure you have enough reserve power for 

a full day’s dosimetry measurements.

2 Check that all batteries are fully charged and the battery switches are on. Battery status can 
be checked on the Control Module from the menu. See “Battery check” on page 20.

Measurement

WARNING:  To maintain hygienic safety and prevent cross-infection, disinfect diode 
before placing it on a patient.

1 Wipe the diode(s) with a pad moistened with an antiseptic solution.

2 Tape the diode(s) in place on the patient.

CAUTION: Never place the Detector Pod or Base Station in the direct beam. You may damage it. 

3 Press a calibrated energy key for the dose to be administered.

• When pressing the key, the Main screen must be visible 
on the Control Module (“Energy Key to Start measuring” 
or last values) and that the READY LED is on.

• Calibrated energy keys have lighted LEDs. If LED next to 
key is out, that key has not been calibrated.

• LED for selected energy key will be blinking during acquisition.

• The message “Starting...” appears briefly.

A  tc=-0.9999999  

B  tc=-0.9999999  

INC=Scroll  ENTER

=Save  STOP=Abort

ENERGY  KEY  to   

Start  measuring  
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• The AQRING LED will light, and the READY LED will go out.

4 Administer the prescribed radiation dose to the patient.

• During administration of the dose, the screen will dis-
play “Measuring, please wait.”

• To print Interim Dose reports, press PRINT after the 
beam turns off. You can then continue treatment with 
another field and the measurement will continue to accumulate. See “Intermediate dose 
report” on page 70.

5 When the beam has turned off, press STOP button on the Control Module.

• AQRING LED will go out, READY LED will go on, and the energy key LED will stop 
blinking.

• If beam was still on when the STOP button was pushed, 
the “Beam is On” message will be displayed to let you 
know that the dose was not finished.
• Push the STOP button to stop acquisition, display 

final dose, and return to collecting background.
• Push the ENTER button to continue the measurement.

• The measured dose for diodes A, B, C, and D will be dis-
played. The values will stay on the screen until the next 
measurement.

• If an un-calibrated button is pushed, the display will 
show nominal charge in nC (nanocoulomb).

• When not acquiring, background is being collected.

• A lower case channel letter will be used and a ‘~’ will be displayed in the ‘=’ sign position 
to let you know when a bad background was collected. i.e. accelerator was on, or exces-
sive leakage. 

• If Base Station or Pod battery is discharging and the run-
ning time is <30 minutes, the “Low Battery...” alternate 
screen appears. Unit Name P= Pod, B= Base Station.

6 Press PRINT button to print the Dose report. See “Reports 
from control module” on page 34.

• Fill in the blanks, sign the report, and file with patient records in accordance with the 
applicable policies of your treatment center.

7 Remove the diodes from the patient, and repeat the process for the next patient.

Data interpretation

If the dose measured by the IVD does not agree with the calculated dose, then an investigation of 
the cause will reveal one of the following:

1 There is an error in the treatment plan calculation.

2 There is an error in the machine or patient setup.

3 The treatment machine is out of calibration.

4 The IVD is improperly calibrated.

5 A failure in the IVD.

In this event, the plan and setup should be reviewed by the physicist. If this does not reveal the 
error, the calibration of the machine output and the IVD should be tested. If this does not reveal 
the error, then either the error is the result of a non-reproducible setup or an IVD failure. Under 
such a condition, the IVD should be used to make another measurement of the treatment dose at 
the next treatment session. Report any evidence of software faults to the manufacturer by tele-
phone, fax, or E-mail. 

Measuring,please

wait             

BEAM  is   ON   STOP

or  ENTER  to  Cont

A=9.9  B=9.9

C=9.9    D=9.9   

LOW  Battery:

B||||| P||
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WARNING:  Under no conditions should the treatment plan be modified based solely upon 
the measurements of the IVD without corroborating evidence of an error resulting from 
situations 1, 2, or 3 as described above.

NOTE: Additional information is available in AAPM Report 87, “Diode in vivo dosimetry for patients 
receiving external beam radiation therapy,” Radiation Therapy Committee, Task Group #62, ISBN 
1-888340-50-9, (2005). The report covers the calibration and use of diodes, as well as the interpre-
tation of results. 

Solving operator problems

Post operational checks (Model 1136)

At the completion of daily operation:

1 Verify that the Base Station is still connected to battery charging power and is charging.

2 Reconnect the Detector Pod to battery charging power. 

• Whenever charging power is connected to the Pod, a beep will sound and the message 
“Pod on External Power” appears.

3 Verify that all batteries are charging (blinking DS1 LED on Pods). Leave the Control Module 
on (powered). If any units were switched or reconnected, return the setup to its original 
configuration.

Reports from control module

About reports

You can print five types of reports. 

• The first two reports are printed by the therapist during daily use: 

• Intermediate Dose Report

• Dose Report

• The remaining three reports are available for the physicist:

• Intermediate Charge Report

• Charge Report

Table 3-5. Common solutions to operator problems

Problem Remedy
System can’t find desired Pod at 
startup.

• Turn on battery switch on wireless Pod.
• Recharge battery on wireless Pod.
• Swap Base Station and Pod.
• Change Pod number in System Select. See “System select” on 

page 20.
• Move the Pod around to a more desirable position for radio trans-

mission. Moving the Pod a few feet may make a difference in the 
transmission or reception.

System finds Pods from another 
system

• Move the system inside the treatment vault.
• Turn off the interfering system.

Message “Nothing found” is dis-
played on startup.

• Connect power or turn on battery.
• Reconnect Control Module properly.

Message “Low Battery” and a beep 
sounds. Display shows which battery 
is low.

• Complete existing operation (you have 30 minutes grace time) and 
recharge battery.

LED DS2 on Pod is blinking rapidly. • Check error code. See “Error codes” on page 80.
• Power down, then power back up. Repeat the procedure that 

caused the problem.
• If problem continues, call Sun Nuclear Customer Service.

Display shows 0 cGy when the beam 
is measured.

• Reset System select to the correct Pod.
• Connect a diode to the Pod.
• Replace a damaged or non-functioning diode.
• Place the diode(s) properly on the patient in the beam
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• Dose Calibration Report

The type of report printed will depend on the operation that was in progress or just completed 
when the PRINT button was pressed.

Using the printer

The optional Seiko DPU-414 thermal printer (Figure 3-2) is used to print reports generated by the 
Control Module.

Figure 3-2. Optional thermal printer

The printer has been set up at the factory. Do not change the internal DIP switch settings. Refer 
to the separate printer Operation Manual for instructions for installing a new paper roll (replace-
ment part number 850043).

To connect and turn on the printer
1 Connect the printer to the Control Module with the serial cable.

2 Connect the printer power cord (black plug) to the printer. Connect the power cord (red plug) 
to the receptacle on the side of the Control Module.

3 Slide the POWER switch on the left side of the printer to the ON position. The Power lamp 
will come on.

4 If necessary, press the ONLINE button, the ONLINE lamp will come on.

5 To feed blank paper, press the FEED button on the printer.

To print a report
1 Press PRINT button on the Control Module. The “Printing...” 

message is displayed for 2 seconds after the PRINT button 
is pushed.

2 The report will scroll out of the printer. 

3 If you press PRINT when no data is available for print, the screen will display “Nothing to 
print.”

The five types of reports are described in the following paragraphs. 

Intermediate dose report

An Intermediate dose report is printed by pressing the PRINT button while the Active LED is 
turned on. It provides an opportunity to print one or more treatment fields before STOP is pressed. 
Each intermediate dose report will contain the accumulated total since the energy key is pressed.

Printing...     
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Figure 3-3. Intermediate dose report

• The date and time on Intermediate dose report will be the date and time of the printout. 

• Print this report when collecting Dose with calibrated inputs.

• Signed by the therapist.

Dose report

The Dose Report is the final report printed after treatment. After STOP is pressed, this report will 
be printed when PRINT button is pressed.

****************************************
INSTITUTION NAME (OPTIONAL)

INTERMEDIATE DOSE REPORT
****************************************
HHMMSS: 08:52:38        DDMMYY: 20/09/00

Patient Name:___________________________
Patient ID:_____________________________
Field:______________ Machine:___________
Energy:________ MU:________ SSD:________

BASESTATION 03, POD O4, KEY 1 (06 MV)

Therapist:_____________________________ 

DOSE:
Channel A= 12.0   cGy   (s/n: 1615126)
Channel B= -0.0 cGy   (s/n: 1615125)
Channel C= 11.6 cGy   (s/n: 1615124)

HHMMSS: 08:52:59
Channel A= 22.1  cGy   (s/n: 1615126)
Channel B= -0.0 cGy   (s/n: 1615125)
Channel C= 21.5 cGy   (s/n: 1615124)

HHMMSS: 08:53:15
Channel A= 42.3   cGy   (s/n: 1615126)
Channel B= -0.1 cGy   (s/n: 1615125)
Channel C= 41.6 cGy   (s/n: 1615124)
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Figure 3-4. Dose report

• The date and time on the Dose report will be the date and time the STOP button was pressed 
at the end of the acquisition.

• Print this report after collecting Dose with calibrated inputs.

• Blank fields should be filled in according to organization policies.

• Signed by therapist.

Intermediate charge report

This report is the same as the Intermediate Dose Report except that it is printed out if an un-cali-
brated energy button is selected.

****************************************
INSTITUTION NAME (OPTIONAL)

DOSE REPORT
****************************************
HHMMSS: 08:52:38 DDMMYY: 20/09/00

Patient Name:___________________________
Patient ID:_____________________________
Field:______________ Machine:___________
Energy:________ MU:________ SSD:________

BASESTATION 03, POD 04, kEY 1 (06 MV)

DOSE:
Channel A= 150.0 cGy   (s/n: 1615126)
Channel B= -0.0 cGy   (s/n: 1615125)
Channel C= 106.6 cGy   (s/n: 1615124)

TEMPERATURES:
Channel A= 9999 cts
Channel B= 9999 cts
Channel C= 9999 cts

Therapist:_____________________________
****************************************
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Figure 3-5. Intermediate charge report

• The date and time on the Intermediate Charge report will be the date and time of the printout.

• Print this report while collecting charge with un-calibrated inputs.

• Signed by the therapist or physicist.

Charge report

This report is similar to the Dose Report except that it is printed if an un-calibrated energy button 
is selected.

****************************************
INSTITUTION NAME (OPTIONAL)
INTERMEDIATE CHARGE REPORT

****************************************
HHMMSS: 08:52:38        DDMMYY: 20/09/00

BASESTATION 03, BOD 04, KEY 1 

Therapist:_____________________________

DOSE:
Channel A= 22.1  nC 
Channel B= 32.4     nC 
Channel C= 9.4  nC 

HHMMSS: 08:53:21
Channel A= 33.5  nC 
Channel B= 51.1  nC 
Channel C= 12.7  nC 

HHMMSS: 08:54:25
Channel A= 45.7     nC 
Channel B= 72.4     nC 
Channel C= 18.4     nC 
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Figure 3-6. Charge report

• The date and time on the Charge report will be the end date and time of the acquisition.

• Print this report after collecting charge with un-calibrated inputs.

• Signed by the therapist or physicist.

Dose calibration report

This report shows the calibration details for a calibrated energy button. 

****************************************
INSTITUTION NAME (OPTIONAL)

CHARGE REPORT
****************************************
HHMMSS: 08:52:38        DDMMYY: 20/09/00

BASESTATION 03, POD 04, KEY 1 

DOSE:
Channel A= 45.7     nC   
Channel B= 72.4     nC 
Channel C= 18.4     nC 

Therapist:_____________________________
****************************************
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Figure 3-7. Dose calibration report

• The date and time on the Dose Calibration report will be the date and time of calibration. 

• Temperature is only shown if the calibration factor is negative.

• The temperature coefficients show 0.0 if temperature coefficient measurement has not been 
done.

• This report will be printed when the calibration coefficients are displayed in dose calibration 
or from View Calibration with a button selected.

• Signed by the physicist.

****************************************
INSTITUTION NAME (OPTIONAL)

   CALIBRATION REPORT
****************************************
HHMMSS: 08:52:38 DDMMYY: 20/09/00

Field:_________________Machine:_________
Energy:__________MU:________SSD:________

BASESTATION 03, POD 04, KEY 1 (06 MeV)

CALIBRATION FACTORS:
Channel A= -0.0021892 (s/n: 1615126)
Channel B= -0.0022169 (s/n: 1615125)
Channel C= -0.0021944 (s/n: 1615124)

TEMPERATURE:
Channel A= 2495 cts
Channel B= 2503 cts
Channel C= 2417 cts

TEMPERATURE COEFFICIENTS:   
Channel A= -0.0004219
Channel B= -0.0002975
Channel C= -0.0003785

Physicist:_____________________________
****************************************
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4 Software operation

About the PC software

The PC software is included on the compact disk (CD) with each system. The PC software lets you 
operate the system with your personal computer. The software operates on any PC with Windows 
95 and higher.

When using a computer, the buttons and display on the Control Module are inactive. You can con-
trol the system with either the computer or the Control Module, but you can’t use them 
simultaneously. 

When the Control Module senses that the PC software is active and connected, the Control Mod-
ule display shows “System under PC Control. 30” If the PC software is switched off or loses 
connection, the Control Module counts down from 30 seconds before resuming control.

To print reports when using the computer, connect any standard computer printer to your com-
puter. When using PC software, the thermal printer is not used. You can also use a printer on your 
network. Computer reports are full page and have a different format and appearance than the Con-
trol Module reports. An additional feature of the computer is the ability to print multiple exposures 
in a single report. 

NOTE: To measure with multiple Pods, you must use the PC software. You cannot use the Control 
Module with more than one detector pod (up to 4 diodes). 

To install the software
1 To install the software on your PC, place the CD in the CD drive and wait for the opening 

screen to appear. 

2 If autorun is not enabled on your CD drive, navigate to the CD drive and double-click on the 
file “SunNuclearCorp.exe” to open the menu. 

3 From the menu, select the option to install software for the IVD.

NOTE: The CD also contains software and documentation for other Sun Nuclear Corporation 
products.

4 Follow the on-screen directions.

To launch and close the software

To launch the software

1 To launch the IVD software, double-click the IVD icon on the desktop.

2 If the desktop icon is missing, select Start > Programs > SNC Group >IVD.

To close the software

To close the software, click on the “X” in the upper right corner or select Exit from the File menu.

To remove the software
1 To remove the IVD software, select Start > Settings > Control Panel > Add or Remove 

Programs. 

2 Select IVD Version (version no.) from the list of programs, and click Remove.

3 Follow the on-screen directions.

Opening view

Once the initialization and system check are complete, the Dose view will be displayed.
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• The system always powers up in the Dose view.

• In the Dose view, the system is ready to make a measurement. 

• The energy keys that have calibration values for connected detectors will have their corre-
sponding buttons shown on the right side of the screen. 

After the first measurement, the Dose view shows the results of the last measurement taken. 

Screen elements

The IVD software uses typical Windows screen elements (Figure 4-1) described below. While 
there may be minor differences in the appearance of the screen under different versions of Win-
dows, the results are the same.

Figure 4-1. Screen elements

Title bar

The Title bar shows the name of the program and contains the standard Windows control buttons: 
Minimize, Maximize, and Close.

Title bar

Menu bar

Display area

Status bar

View tabs

Toolbar
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Menu bar

The menu bar lists the menu commands in groups under the headings: File, Edit, Setup, and Help. 
When you click on a menu item, a drop-down list of commands appears. Table 4-1 lists the menu 
commands available and describes their functions.

Toolbar

The toolbar is a row of buttons and drop-down lists just below the menu bar. The items on the 
toolbar, from left to right, are listed below:

• Start button—starts the dose counter for an exposure. 

• Stop button—stops the dose counter after an exposure is complete.

• Dose/Rate display—shows which mode is selected, Dose mode or Rate mode. In Dose 
mode, the value displayed for each diode detector is the accumulated dose. In the Rate 
mode, the value displayed for each diode detector is the dose Rate in the selected units per 
second. 

• Mode button—toggles between Dose display mode and Rate display mode.

• Setup list—This pull-down list selects the calibrated or uncalibrated memory positions avail-
able for calibration storage.

• Edit button—allows editing of the description of the calibrations on the list and the corre-
sponding buttons.

Display area

The display area is the central part of the window that contains information and controls for the 
selected views.

View tabs

You select a view by clicking one of the three tabs at the bottom of the screen:

Table 4-1. PC software menu functions 

Menu Menu Item What it does Pin
File Log Data Click to select or clear the log data option. When a check mark 

appears next to Log Data, the program creates a text file with 
measurements taken every second. 

No

Load Pod’s Calibra-
tion from File

Causes the data in a calibration file that has been saved to be 
loaded to the Pod.

Yes

Save Pod’s Calibra-
tion to File

Saves a Pod’s calibration data to a file. Yes

Print... In Dose view, prints a dose delivered report. The type of report 
printed will depend on the type of measurement made.

In Dose Calibration view, prints the opened calibration report for 
this setup.

No

Collect for Multi-
Acquisition Print

Sets the system to begin collecting data for multiple acquisitions 
to be printed in a single report.

No

Review Multi Acqui-
sition Print

Opens a dialog box to let you review and print the Multi Acquisi-
tion data.

No

End and Print Multi 
Acquisition

Ends the acquisition of multiple exposures and begins the print-
ing of the multi-acquisition report.

Exit Exits the application after checking for any unsaved files. No

Edit Copy Dose Screen 
Data

Copies Dose screen data to the Windows clipboard. Then you 
can paste the information into a spreadsheet or word processor.

No

Setup Physics Mode Selects and deselects Physics Mode. Yes

Parameter Setup Sets up parameters, including PIN, measurement units, options, 
and institution name.

Yes

Log Active Pods Initiates communications between all active Pods and the Base 
Station. 

No

Select Serial Port Selects serial port to communicate with the Control Module. No

Help IVD help contents Opens program help. No

About Displays software version and manufacturer. No
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• Dose—the technician uses the Dose View for daily In Vivo Dosimetry. The program always 
starts up in this view. 

• Dose Calibration—the physicist uses this view for calibrating each of the 12 available memory 
slots. This view is password-protected.

• Temperature Calibration—the physicist uses this view for entering the temperature calibration 
factors for SNC detectors or determining a temperature correction factor to be applied to 
dose calibration on non SNC diodes. This view is also password-protected.

Status bar

The status bar at the bottom of the window shows messages and status information when 
applicable.

Main views

Dose view

Dose view (Figure 4-2) is the normal operating view used by the technician for daily In Vivo 
Dosimetry.

Figure 4-2. Dose view—multiple pod display

• Display button—toggles between the multiple Pod display (Figure 4-2) and the single Pod dis-
play (Figure 4-3).
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Figure 4-3. Dose view—single pod display

• The body of the display shows the following:

• A color-coded “LED” next to the Pod number. The color shows Pod status:
• Green = acquiring.
• Red = no communication between that unit and the computer.
• Blue = a recurring background measurement is underway.

• ID Number of the Pod(s) connected for this setup. The letter “B” in an 1136 installation 
indicates that the Pod is being used as a base station.

• Diode connections A, B, C, and D for each Pod. The dose or dose rate value for each 
diode is displayed.

• Units selected. You can select between Gy, cGy, and Rads. See “To change dose units” 
on page 56.

• Bat (battery). Three choices are selectable in the parameter setup screen: (1) Percent 
remaining bar, (2) percent remaining text, and (3) Hours:minutes remaining. Letters show 
status: d = discharging, c = charging, t = trickle charging (fully charged)

NOTE: Battery check shows “predicted” battery life, which may differ from actual battery life. 
See “About predicted battery life” on page 87.

• E = error status. If an error condition is present, an “E” will be displayed in this column. 
Right-clicking on the “E” will display the error message. See “Error codes” on page 80.

• Calibrated Setup buttons—clicking these buttons activate the calibrated setups for measure-
ment. Each button represents a calibration factor stored in the selected Pod. By right clicking 
on the button, you can edit the labels for the setups so you can remember the setup condi-
tions for the exposure. These calibrations are the same as the Setups in the pull-down list 
above.

NOTE: The Calibrated Setup “buttons” are the same as the “Energy Keys” on the front panel of the 
Control Module. Clicking a single “button” enables the system to take a measurement using the 
selected calibration.

Dose calibration view

Dose Calibration view (Figure 4-4) is used by the physicist for calibrating the dose for each Pod. 
see “Calibration with PC software” on page 59 for steps in completing calibration.
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Figure 4-4. Dose calibration view

• Energy box—displays the energy setting that was used on the accelerator for this calibration. 

• Save Cal button—saves the current calibration value (Red Check value) to the Pod.

• Cancel Cal button—cancels the current calibration session.

• Inputs to Calibrate—lists the inputs to be calibrated. To select an input for calibration, right-
click the input. A RED CHECK MARK WILL APPEAR NEXT TO THE SELECTED INPUT. The 
diode serial number must be entered for that input.

NOTE: Red check marks appear next to the input for it to be selected!

• Checklist—lists the steps and the sequence of operation for a calibration. This is your list of 
steps to perform a single calibration. During calibration, you click on each task when it is com-
pleted. A check mark appears in the box to identify the completed items. You must complete 
the checklist in the correct order from top to bottom.

• Additional Instructions—lists additional instructions for the step to be completed. Inputs can 
be edited by right clicking on the calibration factor and changing it.

Temperature calibration view

Temperature Calibration view (Figure 4-5) is used by the physicist to measure the temperature 
coefficient of the detector response that will allow compensation during measurement. see “Tem-
perature coefficient measurement” on page 63 for the steps in completing temperature 
calibration.
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Figure 4-5. Temperature calibration view

• Save Cal button—saves the entered/completed temperature calibration to the Pod.

• Cancel Temperature Cal button—cancels the current temperature calibration (if the input is 
selected (Red Check mark).

• Inputs to Temperature Calibrate—lists the diode serial numbers and previous temperature 
coefficients. To select an input for calibration, right-click the input. Once selected, a check 
mark appears next to the selected input. The diode serial numbers are carried over from the 
dose calibration, which has to be completed before temperature calibration can be done. 

• Temperature factors can be entered directly from a chart for SNC detectors and certain other 
manufacturers. If this method is used, the temperature calibration does not have to be done 
which greatly simplifies this process. See “Temperature coefficient (Tc)” on page 62.

• Checklist—lists the steps and the sequence of operation for a temperature calibration. This 
is your list of steps to perform a single calibration. During calibration, you click on each task 
when it is completed. A check mark appears in the box to identify the completed items. You 
must complete the checklist in the correct order from top to bottom.

• Additional Instructions—lists additional instructions for the step to be completed.

Setup for PC software

COM (serial) connection
1 Connect the serial cable between the PC’s serial port and the COM port on the Control Mod-

ule (Figure 4-6).

NOTE: You can permanently install the 25-meter data cable in a conduit between the two rooms. 
For multiple rooms, additional 25-meter data cables can be purchased separately and installed in 
all conduits and control rooms. This will reduce setup time when moving the system from room to 
room. 

2 Connect the instrument to the Control Module with the power/data cable.

3 Plug the power converter into an outlet with 110 to 240 VAC, single phase, 50-60 Hz power. 

4 Connect the power converter to the Control Module.
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Figure 4-6. Typical serial port connection

Serial port alternatives

IVD Solutions operates with either a standard serial port or a USB port. If your computer has nei-
ther port, several alternatives may allow you to connect to IVD Solutions. You can obtain the 
necessary equipment from computer stores, catalogs, and on-line merchants.

• Serial port card—If your computer is a desktop, you may be able to install a serial port card in 
an empty PCI slot.

• PCMCIA card to serial port adapter—if your computer is a laptop, you may be able to install 
a PCMCIA card to serial port adapter in the card slot.

To use these adaptors, follow the manufacturer’s instructions and observe the following steps:

1 Set up the adaptor per manufacturer’s instruction.

2 In the setup, identify the serial port as COM 1 through COM 9 (higher numbers are not 
supported).

3 Connect the serial cable between Control Module and the serial port adaptor.

4 Power up normally. 
NOTE: Sun Nuclear Corporation recommends using a standard serial port or USB port. 
Although many adaptors may work, Sun Nuclear Corporation assumes no responsibility for the 
proper operation of your serial port or serial port adaptor.

USB connection

The Control Module contains a high-speed, USB to Serial converter port. This port allows a serial 
connection through a USB cable. 

The converter operates with Windows 98SE (Second Edition) or higher if the proper USB drivers 
are installed. The converter does not operate in USB mode with Windows 95, 98, or NT 4.0.

Drivers are included with IVD software.

NOTE: Check your software version by clicking Help > About on the application software menu. 
To obtain latest software, check the web site. 

When you install the correct version of the application software, USB drivers are copied to your 
hard drive. The first time you connect your computer to the USB port on the Control Module, you 
are prompted to install the drivers. 

1 With the computer off, connect the cables as shown (Figure 4-7), except DO NOT PLUG THE 
USB CABLE INTO THE PC.
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Figure 4-7. Typical USB port connection

2 Plug the power converter cord into a 110 to 240 VAC, 1-phase, 50-60 Hz power source. 

To power up the system
1 Connect cables and power as described in Section 2. See “Connections” on page 10.

CAUTION: To obtain a valid background measurement, the diodes must be connected to the Detector Pod 
before launching the software.

2 Connect the correct diodes to the detector Pod. (They can remain connected.)

• Make a note of the serial numbers of the diodes and the channels to which they are 
connected.

• The same diodes used for calibration must be connected to the same terminals that were 
used during calibration.

• Diodes must be connected before you launch the software in order to get a valid back-
ground measurement.

3 Verify that the correct Pod is connected. 

• Calibration factors are stored in the Pod’s memory.

4 Turn on power to the Pod(s). 

5 Launch the software. When the software launches, the Dose View will be displayed.

6 From the Setup menu, select Log Active Pods. The system will show the active Pods in the 
center of the screen. 

7 Check to make sure the “LED” next to the Pod number is blue, indicating a recurring back-
ground reading is being collected. 

8 If all the hardware for this system is found, the Background message appears next to the Dis-
play button. This indicates that a background measurement is being taken.

• This is the initial background collection screen before data acquisition.

• Background measurement takes about 30 seconds. 

• After a measurement, the background will count down again. If a measurement is taken 
before the count-down is finished, the previous background value will be used.

9 After initialization, the PC monitor displays the Dose view. 
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To set up initial parameters 

For first-time use, you should select the initial parameter from Setup > Parameter Setup on the 
menu:

1 If you want to enter an administrator PIN (personal identification number) see “To set or 
change a PIN” on page 55. Using a PIN forces the operator to enter the PIN prior to making 
important settings. This prevents accidental or inadvertent changes when several people are 
using the system. If you don’t want to use a PIN, enter 0000, or if there is already a PIN, 
change the existing PIN to 0000.

2 The default dose unit for display is cGy. To change to Gy or Rad, see “To change dose units” 
on page 56.

3 Each unit is assigned a number. To change a device ID, see “To set or change a device ID” 
on page 59.

4 You can enter an optional Institution Name to be printed at the top of each printed report. See 
“To enter an institution name” on page 56.

To set up a serial connection

If COM 1 is free and is working properly, the serial port will connect and operate automatically. You 
don’t need to do anything.

The IVD software defaults to COM port 1. If the port is not working, no Pods will be found when 
you attempt the Log Active Pods command.

To find a COM port

If the computer does not automatically find the COM port of the Control Module, perform the fol-
lowing steps:

1 Click Setup > Select Serial Port. The Select Port dialog opens (Figure 4-8).
 

Figure 4-8. Serial port setup

2 Click the Find button. The computer will automatically locate the Control Module and assign 
a port.

To change the COM port 

If you know what the COM port is, you can assign it:

1 Select Serial Port from the Setup menu. The Select Serial Port dialog box opens (Figure 4-8).

2 Select the desired COM port and click OK.

NOTE: Only available COM ports will be displayed. 

3 Click OK to close the messages.

4 Close the IVD Windows application program and then re-launch it.

5 The connect messages appear.

Serial port troubleshooting

If you can’t connect on any port, see “Before requesting help” on page 89. Or contact Sun Nuclear 
Technical Support by phone, 321-259-6862, or via email, techsupport@sunnuclear.com.
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To set up a USB connection

Use this procedure if you are connecting via the USB port. If using the serial port, see “COM 
(serial) connection” on page 47.

To Install USB drivers for Windows XP 

When you previously installed the software, the USB drivers were automatically loaded on your 
hard drive

1 Turn on the computer and boot Windows.

2 Plug the USB cable into the computer. Windows will automatically detect new hardware.

3 If connected to the Internet and the Windows Automatic Update feature is turned ON, wait 
while the operating system automatically downloads and installs the proper drivers. A status 
icon appears in the system tray as the operating system goes through this process. After-
ward, see “Verifying installation of USB drivers” on page 54. 

4 If the computer is NOT connected to the Internet OR the Windows Automatic Update feature 
is turned off, Windows will pop up a “Found New Hardware” flag on the system tray, and 
open the Found New Hardware Wizard (Figure 4-9).

Figure 4-9. Found new hardware wizard

5 Select “Install from a list or specific location (Advanced)” and click Next. A dialog appears (Fig-
ure 4-10). 

Figure 4-10. Choose search and installation options
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6 Click “Search for the best driver in these locations” and check “Include these locations in the 
search.” The location of the drivers that were installed with the current version of the instru-
ment software are displayed. 

7 Click Next. A security warning may appear (Figure 4-11).

Figure 4-11. Install hardware drivers dialog box

8 Click “Continue Anyway.” A dialog box appears when finished (Figure 4-12).

Figure 4-12. Install hardware drivers dialog box

9 Click Finish to complete the installation. The Found New Hardware Wizard will open again 
(there is another driver to install).

10 Repeat steps 2 through 6 to install the second driver. When completely finished, a pop-up flag 
on the icon tray will say “Found New Hardware. Your new hardware is installed and ready to 
use.” This completes installation of the drivers.

11 Launch the IVD application software.

To install USB drivers for Windows 2000 

1 Turn on the computer and wait for Windows to boot. Windows will automatically detect the 
USB device and display a “New Hardware Detected” message, The Found New Hardware 
Wizard opens (Figure 4-9).
52 Section 4. Software operation



Figure 4-13. Found new hardware wizard

2 Click Next. The Install Hardware Device Drivers dialog appears (Figure 4-10).

Figure 4-14. Install hardware drivers dialog box

3 Select “Search for suitable driver…” and click Next. The Locate Driver Files dialog box appears 
(Figure 4-11).

Figure 4-15. Install hardware drivers dialog box
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4 Select “Specify a location,” clear any other check boxes, and click Next. The computer will 
search for a driver, install it, and display the results (Figure 4-16).

5 Click Next to install the ftdibus.inf driver.

6 Repeat steps 2 through 6 to install the ftdiport.inf driver. This completes the driver installation

7 Launch the application software.

Figure 4-16. Install hardware drivers dialog box

Installing USB drivers for Windows 98SE and ME

Installation for Windows 98SE and ME is similar to Windows 2000, except that the screens have 
a slightly different appearance, and you must manually enter the location of the drivers.

Drivers are located in the following directory:

• C:\Program Files\SNC\IVD2\USBDriver
NOTE: Pull down the list in “Include this location in the search” in the Found New Hardware 
Wizard to find the location of the drivers.

Verifying installation of USB drivers

If you want to verify the installation, select Control Panel > System > Hardware > Device Manager 
> View > Devices by type. In the Device Manager window, expand the Ports (COM/LPT) to show 
“USB Serial Port (COM n)” where n is the port number assigned (Figure 4-17).

Figure 4-17. USB serial port listing in Device Manager

Using the USB connection

Use the USB connection the same as you would the serial connection.

NOTE: Do not disconnect the USB cable until after you have closed the application software to pre-
vent loss of data.
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Connecting multiple instruments to USB

If you use multiple instruments with one computer (for example, an IVD and a DQAC) each instal-
lation is assigned a different serial port number. You must know which serial port is assigned to 
each instrument and select only that port when running that instrument. Or you can use the 
“Detect” or “Find Port” commands to detect the instrument.

Removing the USB drivers

To remove the USB drivers, open Control Panel (Start > Settings > Control Panel) and double click 
on Add/Remove Programs. In the Add/Remove Programs dialog box, select “FTDI USB Serial Con-
verter Drivers” and click Change/Remove. Follow the on-screen directions.

Parameter setup

The Parameter Setup item on the Setup menu lets you 

• enter or change the PIN (Personal Identification Number), 

• select the printout characteristics

• select the type of display for battery status,

• select the type of dose units to be displayed, 

• set the RV Portal Software to run at start, 

• suppress background subtraction for uncalibrated inputs, and 

• enter an Institution Name that will be printed at the top of the printed reports.

To set or change a PIN 

The administrator PIN protects patient safety by preventing unsafe connections. In addition, the 
PIN avoids accidental changes to setup and calibration. To use no PIN, enter 0000. 

1 Select Parameter Setup from the Setup menu. This opens the Setup Parameters dialog box 
(Figure 4-18).

Figure 4-18. Setup parameters dialog box

2 Click the Setup Physics Pin button to open the Password dialog box.

3 In the Password dialog box, enter the PIN once, then enter it again to confirm.

4 Click OK.

NOTE: If the PIN is lost or forgotten, the physicist can key in “0911” to display the stored PIN. After 
0911 is entered, fill in the stored PIN and press ENTER to continue. Then the existing PIN can be 
used, or the PIN can be changed.

About the medical power supply

The medical power supply, P/N 741008, is required for use with the Models 1136 and 1137. The 
medical power supply can be identified by the label “Medical Power Supply” on the top surface.
Setup for PC software 55



When the medical power supply is used, the Medically Approved Power Supply box should be 
checked. If the box is cleared, the software will force you into Physics Mode whenever a wired 
connection to a Pod is detected.

To remove a PIN

• To remove a PIN, enter four zeros when prompted.

To make printout selection

This setup option lets you select one of two options to change the appearance of reports:

• Space for Expected Dose—causes a blank to appear with the heading “Exp Dose” so that the 
therapist can write in the expected dose (from plan) next to the actual dose (measured).

• Temperature Counts—causes the junction voltage counts to appear with the heading “Temp 
Cnts” next to the actual dose. Temperature counts allow you to independently verify temper-
ature calibration by calculation.

To select battery status display

You can change the battery status display to show three different types of remaining battery life 
with an accuracy of about ±10%:

• Percent Bars—a horizontal bar that shows the approximate battery life remaining.

• Percent Text—a text display of percent battery life remaining.

• Hours and Minutes—hours and minutes of remaining battery life assuming continuous beam 
on measurement. Actual operating time with intermittent measurement is about twice as 
long.

See “About predicted battery life” on page 87 for more information about predicted battery life.

To change dose units

This option is used to select the dose units that are displayed and printed. Administrator PIN is 
needed.

1 Select Parameter Setup from the Setup menu. 

2 Enter your PIN and click OK. This opens the Setup Parameters dialog box (Figure 4-18).

3 Click the button next to the units you want to display.

• Units are cGy (centigray), Gy (gray), Rads (rad).

4 Click OK.

To run RV Portal software

Normally, this option is not checked. However, if you have installed Sun Nuclear’s Record and Ver-
ify Portal software, check this box to run the software at startup.

NOTE: Record and Verify Portal Software operates as a bridge to provide data to Nucletron Oncen-
tra RV/VISIR Record and Verify software. For additional information, refer to Oncentra 
documentation, the Sun Nuclear Record and Verify Portal Software manual, or contact Sun Nuclear 
Corporation Sales Department.

To suppress background subtraction for uncalibrated inputs

Normally, this option is not checked. However, for troubleshooting, this option allows you to sup-
press background subtraction for un-calibrated inputs. Thus, the uncorrected values can be 
displayed. 

To enter an institution name

An optional Institutional name can be entered via the dialog box so that the Institution’s name 
appears at the top of every printed report. The Institution name can be a maximum of 70 charac-
ters and will be centered on the top text line of each printed report. Administrator PIN is needed.

1 Select Parameter Setup from the Setup menu.
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2 Enter your PIN and click OK. This opens the Setup Parameters dialog box.

3 Type the desired institution name in the space provided and press OK to accept or Cancel to 
abort.

To log active pods

When the system is powered up, the connected Pods are not communicating with the software. 
To establish communication, you must activate the Log Active Pods command on the Setup menu.

1 Connect and power-up the system.

2 Select Setup > Log Active Pods.

3 Wait approximately 15 seconds for the connected Pods to appear on the main screen. 

NOTE: If the Pods do not appear, check to be sure the battery switches are on.

To check the battery

NOTE: Only Model 1136 rf-IVD2 wireless Pods have batteries.

You can check the remaining battery life and the state of each battery from the display on the Dose 
view (Figure 4-19). 

Figure 4-19. Battery status (Bat)

• Battery status is shown as follows:

• Three choices are selectable in parameter setup screen: (1) Percent remaining Bar, (2) 
Percent remaining Text, and (3) Hours:minutes remaining

• If hours and minutes are shown, the numbers displayed are predicted hours and minutes 
of measurement time left (not including a 30-minute safety factor). If the system is idle 
(not measuring), the batteries will last about twice as long as shown on the display. See 
“About predicted battery life” on page 87.

• Status: c = charging (battery is discharged and is charging at maximum rate), t = trickle 
charging (a full charge is being maintained with a trickle of power), d = discharging, o = 
battery switch is off. 

• A battery can show “off” when fully charged.
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• A fully-charged battery will indicate 5 to 7 hours on trickle charge.

To view the software version

You may need to check the software version when speaking to Sun Nuclear Corporation Technical 
Support.

1 Click About on the Help menu.

2 A dialog box opens showing the current software version. 

3 Click OK to return to the main window.

To view firmware versions of pods 

You may need to check the firmware versions when speaking to Sun Nuclear Corporation Techni-
cal Support and to check that the Base Station and Pod have the same version.

1 Power up the system and select Log Active Pods from the Setup menu.

2 Select the multiple Pod display by toggling the Display button.

3 Place the cursor over the Pod or Base Station number you want to check and right-click the 
mouse.

4 A pop-up box will show the firmware version for the selected unit (Figure 4-20).

CAUTION: In a given setup, all Pod and Base Station firmware versions should be the same.

Figure 4-20. Firmware version display

To copy, edit, and paste calibration data

You can copy, edit, and paste correction factors, temperature coefficients, serial numbers, etc. 
using the standard Windows Copy and Paste function by right-clicking in the edit box.

CAUTION: Pasting or editing overrides the calibration procedures and may result in inaccurate data.

1 Open the Dose Calibration View and expand the listing to include the desired source of the 
coefficient.
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2 Right-click the coefficient to be copied. The coefficient will be highlighted.

3 Right-click to open the context menu (Figure 4-21) and select Copy.

Figure 4-21. Context menu

4 Navigate through the listing to open the destination for the coefficient. 

5 Place the cursor where you want to paste the coefficient.

6 Right-click to again open the context menu and select Paste. The coefficient will be copied to 
the new position.

Or...

Highlight a box and edit the value.

7 Click the Save Cal button to save the copied coefficient to the Pod or click the Cancel Cal but-
ton to exit without saving.

To set or change a device ID 

Device ID numbers are assigned at the factory. Normally they will not be changed throughout their 
life. However, if you happen to purchase additional Pods, exchange Pods from another treatment 
room, or are using Pods from two different systems, you may need to change a device ID number 
to prevent having duplicate numbers. 

You can change the device ID number by using the SNCutility.exe program used for downloading 
new firmware into your Pod. This program is located on the distribution CD. 

Prior to changing the device ID number, please call Sun Nuclear Customer Support for assistance. 
A representative will guide you through the process.

CAUTION: Improper use of the SNC utility program may erase the embedded firmware and all calibration fac-
tors in the Pod rendering it unusable.

Calibration with PC software

Calibration overview

Before using the IVD equipment, you must calibrate the system for different beam energies. Tem-
perature calibration (negative diodes only) is optional. Both of these calibration factors are stored 
in non-volatile memory in the Detector Pod on which the calibration was performed.
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Beam energy calibration is assigned to a specific button; temperature correction factor is 
assigned to all buttons using the diode serial number and exposure parameters to which the tem-
perature correction factor applies.

In daily operation, clicking a single calibrated energy button prepares the system for measure-
ment. One-button operation simplifies the therapist’s daily work. 

To standardize setup and prevent mistakes in operation, the physicist should consider the follow-
ing suggestions:

• Select one of the connection methods appropriate to your needs and stick with it.

• Mark each Pod and Base Station with its unit number. Remember, correction factors are 
stored in each Pod, not the Control Module or PC. 

• Edit the setup description for each energy setup or “button” calibrated, including the param-
eters to which the button was calibrated. 

• If you have multiple Pods, use a consistent method for assigning buttons to beam energies. 
Example: button 1=6 MV, button 2=18 MV, etc. on all Pods.

• Use consistent placement of diodes on Pod connectors A, B, C, and D.

To calibrate a “button”
When you perform a Dose Calibration, you are setting up a “button” that invokes correction factors 
specific to the beam energy, diode, and hardware for a specific input. The “buttons” appear in the 
Dose view only after they have been calibrated. 

The button setups are listed in the Setup pull-down list on the Toolbar. You can perform up to 12 
calibrations, identified as “Setup 1” through “Setup 12.” 

To calibrate a button, use the following procedure.

1 Connect and energize the Pod(s) you want to calibrate. 

2 Click the Dose Calibration tab at the bottom of the screen. The Password dialog box appears.

3 Enter your PIN and click OK.

4 Select the Setup Number to calibrate.

5 Now follow the on-screen “Check List” (Figure 4-22).

Figure 4-22. Using the check list to calibrate diodes
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• The Check List is in the upper right corner of the Dose Calibration view.

• Starting at the top, complete each item.

• For each item on the Check List, there may be Additional Instructions below.

• When an item on the Check List is completed, click the check box and go to the next 
item.

• Continue through the entire check list.

CAUTION: Be sure the input(s) to be calibrated are selected with a RED CHECK. 

6 After the beam goes off and the Stop button is clicked, you will be asked for the administered 
dose and energy. Enter the correct values in the dialog box.

7 After a few seconds, the display shows the calculated correction factors for each diode. You 
should review the calibration factors to verify that they are reasonable.

8 Pressing PRINT will print a report for this calibration. For printout details, see “Dose calibra-
tion report” on page 75.

9 If correct, save the calibration factors by clicking the Save Cal button. The calibration factors 
will be saved to the selected Pod location.

CAUTION: Validate after calibration!

Immediately after calibration, the diode calibration should be validated at the same reference con-
ditions used during calibration. This measurement should be performed in the same manner as 
will be used for patient dosimetry. These results should be recorded for future reference and 
repeated at least monthly for trend analysis.

To review and print calibration

You can display and print the calibration factors for the selected button at any time. Administrator 
pin is needed.

To view calibration

1 Click the Dose Calibration tab at the bottom of the screen.

2 When prompted, key in your 4-digit administrator PIN number, and press Enter.

3 In the display area of the screen, select the Pod containing the calibration factors to be 
viewed.

4 Select the Setup number from the pull-down list.

5 Expand the Inputs to Calibrate list to see the correction factors.

6 To exit, click on the Dose tab at the bottom of the screen.

To print calibration

1 To print out a report for a calibration, first view the calibration. 

2 While the calibration factors are on the screen, select Print from the File menu.

3 Change the number of copies or other items in the Print dialog box.

4 Click OK. 

For printout details, see “Dose calibration report” on page 75.

To delete calibration

1 To delete the button’s calibration factors, first select and open the calibration factors for view-
ing. See “To view calibration” on page 61.

2 Right-click to highlight the serial number of the diode whose calibration factor is to be 
deleted. 

3 Enter a zero in the serial number box for each calibration you want to delete.
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NOTE: Be sure a red check mark appears in front of the edited calibration factors before saving. 
The red check marks must be visible in order to save the edited calibration factors.

4 When all the calibrations have had their serial numbers zeroed for this setup, click the Save 
Cal button. 

5 The correction factors stored in the Pod are deleted, and a confirmation message appears on 
the screen.

Saving and reloading a pod’s calibration file

Calibration information is stored in the Pod’s memory. However, you can save a Pod’s calibration 
data to a file and then re-load it in the Pod at a later time. 

This lets you alternate the use of different sets of detectors and their calibration factors with a sin-
gle Pod.

Saving a pod’s calibration file

1 Connect the diode(s) to the desire channel(s).

2 Enter the temperature coefficients and V’ or determine them experimentally.

3 Perform the calibration of the diodes at the energy levels desired. 

4 Click File > Select Save Pod’s Calibration to File. A Save file dialog box appears.

5 Change location as necessary (you can store it wherever you want) and enter a descriptive file 
name.

6 Click OK to save the calibration data to a file.

Loading a pod’s calibration file 

1 Connect the diodes to the channels on which they were calibrated.

CAUTION: Be sure you connect the same diodes to the same channel on which they were calibrated. Be sure 
you are loading the calibration file into the correct Pod number.

2 Click File > Load Pod’s Calibration from File.

3 Navigate to the location of your calibration files and select the desired file.

4 Click OK. The data from the file overwrites the contents of the Pod’s memory.

Temperature coefficient (Tc)

The dose response of diodes varies with changes in temperature. The “Temperature coefficient” 
(Tc) is the fractional change in response per unit of junction voltage across the diode. The junction 
voltage varies inversely with the temperature, and is measured with a 12-bit analog-to-digital con-
verter. For most diodes, a change of approximately 10 analog-to-digital units is equivalent to a 
change of 1 degree Celsius.

In models 1136 and 1137, you must determine your own temperature coefficient by either: 

• Using a lookup table and entering a value (see below)

• Measuring temperature coefficient (see “Temperature coefficient measurement” on page 63)

To enter Tc and V’ from table

The temperature coefficient table provides reasonably accurate temperature coefficients based 
on the model number, serial number, and manufacturer of the diode you are using.
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NOTE: For detectors not manufactured by Sun Nuclear Corp., the data may not be updated. Please 
contact the manufacturer for the updated information.

To enter Tc and V’ from table, perform the following steps

1 Click the Dose Calibration tab at the bottom of the screen.

2 Expand and select the diodes for which you want to add the Tc and V’ data from the table.

3 Type the values directly into the furnished spaces.

Temperature coefficient measurement

If you want to determine temperature coefficients experimentally, you can do so using the follow-
ing procedure.

Preparation

This procedure is used to perform temperature coefficient measurement for a Detector Pod and 
diode combination. Administrator pin is needed.

NOTE: Only negative diodes can be measured for a temperature coefficient.

To perform this procedure, you will need the following additional equipment:

• standard microwave oven

• a small water-filled bag, such as a locking sandwich or freezer bag

It is assumed that treatment room ambient temperature is about 22 °C (72 °F) and that the water 
bag will be heated in the microwave oven to about 38 °C (100 °F). First, a measurement is taken 
at ambient temperature. Then the bag is heated and placed over the diodes and another measure-
ment is taken. The temperature coefficient is calculated from the two measurements.

For calculation details, see “Calculations” on page 77.

Application of temperature coefficients

A calculated temperature coefficient only applies to a single diode serial number. The same tem-
perature coefficient can be applied wherever that same diode serial number is used, as long as 
the instantaneous dose rate is within an order of magnitude. (Some diodes have been found to 
have a different temperature coefficient with Co-60 beams than with accelerator beams.)

Generally, a group of diodes from the same manufacturing lot will have nearly the same tempera-
ture coefficient, but for best results, it is better to determine the temperature coefficient for each 
diode. 

In accelerator beams, the instantaneous dose rate within the pulse of radiation is on the order of 
10,000 cGy/s. In Co-60 beams, the instantaneous dose rate is on the order of 5 cGy/s. So, even 
though both beams have an average dose rates of about 300 cGy/min, there can be a significant 
difference in the temperature coefficient for a diode in these two beams. 

Table 4-2. Nominal temperature coefficients of commercial diode detectors 

Detector name Manufacturer Temperature coefficient
(%/°C)

V'
(mV/°C)

Isorad Sun Nuclear 0.3 ± 0.1 -2.2 ± 0.1

Isorad-p 

QED (p-type) (S/N below 3323601)
Sun Nuclear 0.3 ± 0.1

-2.4 ± 0.1

Isorad-III Sun Nuclear 0.5 ± 0.1 -2.1 ± 0.1

QED (n-type) (S/N 3323601 and 
up)

Sun Nuclear 0.6 ± 0.1 -2.0 ± 0.1

Hi-pSi Scanditronix 0.4 N/A

3G-pSi Scanditronix 0.25 -2.0 ± 0.1

Veridose Nuclear Associates 0.5 N/A

In-vivo Semi-Conductor probes PTW 0.15 N/A
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In TBI beams where the SSD is 300 to 400 cm, the instantaneous dose rate will be 1/10 of that at 
100 cm. Here also, it may be advisable to remeasure the temperature coefficient for TBI applica-
tions. In different beam energies, the instantaneous dose rate within a pulse is typically within a 
factor of 2 or 3 and should not contribute to measurable changes of temperature coefficient.

To measure temperature coefficient 

1 Position the diodes on a room-temperature phantom, in the same manner as used for dose 
calibration. The phantom is required as a thermal mass during the test. See Figure 4-23 for 
diode spacing. 

Figure 4-23. Place water bag over diodes prior to exposure

2 Connect and energize the Pod(s) you want to calibrate. 

3 Click the Temperature Calibration view tab at the bottom of the screen. The Password dialog 
box opens.

4 Enter your PIN and click OK.

5 Now follow the on-screen “Check List” (Figure 4-24).

• The Check List is in the upper right corner of the Temperature Calibration view.

• Starting at the top, complete each item.

• If a diode is being used on multiple setups, the same temperature calibration can be 
applied to all setups by selecting each setup using that diode and selecting its input for 
temperature calibration.

• For each item on the Check List, there may be Additional Instructions below.

• When an item on the Check List is completed, click the check box and go to the next 
item.

• Continue through the entire check list.

NOTE: The displayed temperature coefficients are in terms of fractional response change to a junc-
tion voltage change of the diode. The junction voltage is a linear function of temperature. The 
junction voltage is measured with an analog to digital counter, displayed in “A2D” counts. There-
fore, the displayed temperature coefficient is not a very recognizable quantity. 

6 Validate the application of the temperature coefficients as follows:
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a. Position detectors on room temperature buildup and make a measurement under cali-
brated conditions. This result should be reasonably accurate.

b. After that measurement, place the warmed water bag on the detector for about 2 min-
utes, remove the bag, and repeat the measurement.

c. The second measurement should agree with the first room temperature measurement 
within 1 or 2 percent.

Figure 4-24. Temperature calibration view

Copying temperature coefficients

Whenever you have setups using the same diode on the same channel in the same Pod, you can 
copy the temperature coefficient from the first temperature calibration to the other setups. You 
do not have to perform the calibration for each instance of the diode serial number. You only have 
to do it once. See “To copy, edit, and paste calibration data” on page 58.

However, if you use the same diode on a different channel, or different Pod, you should repeat the 
temperature calibration. 

Measurements with PC software

To prepare for daily operation
1 Allow the batteries to charge overnight. This will ensure you have enough reserve power for 

a full day’s dosimetry measurements.

2 Check that all batteries are fully charged and the battery switches are on. Battery status can 
be checked on screen in the Dose view.

3 Power up the computer and launch the software.

4 Click Setup > Log Active Pods to activate communication with the Pods.

To make a daily measurement

WARNING:  To maintain hygienic safety and prevent cross-infection, disinfect diode 
before placing it on a patient.

1 Wipe the diode(s) with a pad moistened with an antiseptic solution.
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2 Tape the diode(s) in place on the patient.

CAUTION: Never place the Detector Pod or Base Station in the direct beam. You may damage it. 

3 Click a Calibrated Setup button in Dose view to prepare the IVD for dose measurement. (The 
Start button is automatically initiated.)

4 Administer the prescribed radiation dose to the patient.

• During administration of the dose, the simulated LED(s) next to the measuring Pod(s) will 
be blinking green.

5 When the beam turns off, press Stop button.

• If beam was still on when the Stop button was pushed, the “Beam is On” message will 
be displayed to let you know that the dose was not finished. 
• Click the OK button to stop acquisition, display final dose, and return to collecting 

background. (If you continue to Stop with the beam on, the background collected 
will not be accurate.)

• Click the Abort button to continue the measurement.

• The measured dose for diodes A, B, C, and D will be displayed. The values will stay on 
the screen until the next measurement. 

• When not acquiring, background is being collected.

• A lower case channel letter will be used and a ‘~’ will appear next to the displayed dose 
to let you know when a bad background was collected. i.e. accelerator was on, or exces-
sive leakage. 

• To print Interim Dose reports, press PRINT after the beam turns off (do not press STOP). 
You can then continue treatment with another field and the measurement will continue 
to accumulate. See “Intermediate dose report” on page 70.

6 Click Print on the File menu to print the Dose report. See “Dose report” on page 71.

• Fill in the blanks, sign the report, and file with patient records in accordance with the pol-
icies of your treatment center.

7 Remove the diodes from the patient, and repeat the process for the next patient.

WARNING:  To maintain hygienic safety and prevent cross-infection, diodes should be 
cleaned with an antiseptic solution or equivalent before placing them on another patient.

Data interpretation

If the dose measured by the IVD does not agree with the calculated dose, then an investigation of 
the cause will reveal one of the following:

1 There is an error in the treatment plan calculation.

2 There is an error in the machine or patient setup.

3 The treatment machine is out of calibration.

4 The IVD is improperly calibrated.

5 A failure in the IVD.

In this event, the plan and setup should be reviewed by the physicist. If this does not reveal the 
error, the calibration of the machine output and the IVD should be tested. If this does not reveal 
the error, then either the error is the result of a non-reproducible setup or an IVD failure. Under 
such a condition, the IVD should be used to make another measurement of the treatment dose at 
the next treatment session. Report any evidence of software faults to the manufacturer by tele-
phone, fax, or E-mail. 

WARNING:  Under no conditions should the treatment plan be modified based solely upon 
the measurements of the IVD without corroborating evidence of an error resulting from 
situations 1, 2, or 3 as described above.
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The American Association of Physicists in Medicine (AAPM) has issued Report 87, “Diode in vivo 
dosimetry for patients receiving external beam radiation therapy,” ISBN 1-888340-50-9, (2005), 
Radiation Therapy Committee, Task Group #62. This report covers the calibration, use, and inter-
pretation of results. 

Solving operator problems

To perform post operational checks (Model 1136)

At the completion of daily operation:

1 Verify that the Base Station and Pod are connected to battery charging power and are 
charging.

2 Reconnect the Detector Pod to battery charging power. 

3 Verify that all batteries are charging (blinking DS1 LED on Pods). If any units were switched 
or reconnected, return the setup to its original configuration.

To log data

A data logging function is available for troubleshooting or special studies. By checking the Log 
Data command on the File menu, you can cause a data log text file to be written to disk for every 
measurement.

When the menu is checked, the program writes data to C:\Program Files\SNC\IVD\data.txt once 
per second during the measurement. The tab-separated “data.txt” file can be viewed with a 
spreadsheet or other text editor. 

NOTE: Subsequent measurements overwrite the “data.txt” file.

To make “multi acquisition” measurements

This option lets you make multiple measurements but accumulate all measurements on one 
report.

Collect for multi acquisition print

1 Click File > Collect for Multi Acquisition Print. The header dialog box opens.

2 Fill in the header dialog box with the data pertinent to the exposure.

3 Click OK.

4 Make the exposure.

5 If desired, review the data (see below)

6 Repeat steps 1-5 for all subsequent exposures.

Table 4-3. Common solutions to operator problems

Problem Remedy
Pod not shown at startup. • Find Pod using Setup > Log Active Pods command on menu.

• Turn on battery switch on wireless Pod.
• Recharge battery on wireless Pod.
• Swap Base Station and Pod.
• Move the Pod around to a more desirable position for radio trans-

mission. Moving the Pod a few feet may make a difference in the 
transmission.

Control Module not shown at startup. • Connect power or turn on Control Module.
• Reconnect Control Module properly.

Message “Low Battery” and a beep 
sounds. Display shows which battery 
is low.

• Complete existing operation (you have 30 minutes grace time) and 
recharge battery.

LED DS2 on Pod is blinking rapidly. • Check error code shown in error message. Right-click on the “E” 
column next to the Pod in the Dose screen. See “Error codes” on 
page 80.

• Power Pod down, then power back up. Repeat the procedure that 
caused the problem.

• If problem continues, call Sun Nuclear Customer Service.
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Review multi acquisition print

1 Click File > Review Multi Acquisition Print. The review dialog opens.

2 Check the exposures.

3 Continue collecting exposures or end and print multi acquisition.

End and print multi acquisition

When finished with all exposures for the printout, click File > End and Print Multi Acquisition. All 
of the stored exposures will print on a single report.

TBI measurements with multiple pods

If you use the IVD application software, you can connect multiple Pods for Total Body Irradiation 
(TBI) measurements. You can perform up to 28 simultaneous measurements if you use up to 7 
wired detector Pods. Or you can perform up to 52 simultaneous measurements if you use up to 
13 wireless Pods. 

1 Before treatment, perform the following tasks:

a. Set up and identify the Pods. 

b. Connect and calibrate all the diodes.

2 Tape the diodes to the patient according to the measurement plan. Write down the location 
each diode on the patient along with the diode letter and Pod number at the corresponding 
location.

3 Open the Application software, verify all Pods are present and diodes listed.

4 Click Start.

5 Irradiate the patient.

6 After the accelerator turns off, click Stop.

7 If desired, copy and paste the measurement values from the screen of the IVD application 
software into a spreadsheet. 

8 If desired, print a report. See “PC software reports” below.

PC software reports

About reports

The following reports are available for therapist use to record daily testing:

• Intermediate Dose Report can be printed to show the accumulated dose up to that point 
when making multiple exposures.

• Dose Report can be printed at the completion of a dose.

• Multi-acquisition Report contains a series of dose measurements in a single report.

In addition, the physicist may find the following reports useful:

• Intermediate Charge Report can be printed to show the accumulated dose up to that point 
when making multiple exposures using an un-calibrated energy key.

• Charge Report can be printed at the completion of a dose when using un-calibrated energy 
key.

• Calibration Report can be printed to show details of a calibration.

The type of report printed will depend on the operation that was in progress or just completed 
when the PRINT button was pressed. 

The time and date shown on each report is derived from the PC system clock. You can select any 
system printer that is connected to your PC.
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To print a report
1 Be sure the selected system printer is properly connected and turned on.

2 Complete the procedure for which you want a report.

3 Select the view appropriate to what you are doing.

4 Select Print from the File menu.

5 To change printer or printer settings, click Properties and make the necessary changes in the 
Windows printer setup dialog box.

6 Click OK. A header dialog box appears (Figure 4-25).

Figure 4-25. Print header dialog box

7 Enter the appropriate report header information and click OK.

8 The report will be printed on the selected system printer.
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Intermediate dose report

An Intermediate dose report is printed by pressing the PRINT button while the Active LED is 
turned on. It provides an opportunity to print one or more treatment fields before STOP is pressed. 
Each intermediate dose report will contain the accumulated total since the energy key is pressed.

Figure 4-26. Intermediate dose report

• The date and time on Intermediate dose report will be the date and time of the printout as 
determined by the PC system clock. 

• Print this report when collecting Dose with calibrated inputs.

• Signature space for therapist, physicist, and doctor.
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Dose report

The Dose Report is the final report printed after treatment. After STOP is pressed, this report will 
be printed when PRINT button is pressed.

Figure 4-27. Dose report

• The date and time on the Dose report will be the date and time the STOP button was pressed 
at the end of the acquisition as determined by the PC system clock.

• Print this report after collecting Dose with calibrated inputs.

• Blank fields should be filled in according to organization policies.

• Signature space for therapist, physicist, and doctor.
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Multiple acquisition report

You can collect a series of up to 20 sequential measurements and print them in a single report 
(Figure 4-28).

For example, you may want to make measurements throughout a patient’s treatment session, but 
print them on a single report. This feature lets you print up to 20 measurements on a report with 
a single header.

Figure 4-28. Multiple acquisition report

1 Click the Start button and begin the first exposure. 

2 Click Stop button when the exposure is done.

3 Click File > Collect for Multi-acquisition Print for each acquisition to log the data for printing. 
The Header dialog box opens.

4 Enter the Header information in the dialog box for this exposure.

5 When you have completed the series of exposures, you can chose Click File > Review Multi-
acquisition Print to review all the exposures taken and choose to not print one or more expo-
sures if necessary. 

6 Then click File > End and Print Multiple Acquisition. The print dialog opens.
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7 Select and set up the printer and click OK. The multiple acquisition Dose Report prints on the 
selected printer.

NOTE: Once you click the End and Print Multiple Acquisition, the data will be cleared from memory 
the next time Start is pushed. You can reprint the report again if you have not clicked Start. When 
you click start for the next measurement, the previous values are cleared from memory. and a new 
session will be started.

NOTE: These values are not retained once the program closes.

Intermediate charge report

This report is the same as the Intermediate Dose Report except that it is printed out if an un-cali-
brated energy button is selected.

Figure 4-29. Intermediate charge report

• The date and time on the Intermediate Charge report will be the date and time of the printout 
as determined by the PC system clock.

• Print this report while collecting charge with un-calibrated inputs.

• Signature space for therapist, physicist, and doctor.
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Charge report

This report is similar to the Dose Report except that it is printed if an un-calibrated energy button 
is selected.

Figure 4-30. Charge report

• The date and time on the Charge report will be the end date and time of the acquisition as 
determined by the PC system clock.

• Print this report after collecting charge with un-calibrated inputs.

• Signature space for therapist, physicist, and doctor.
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Dose calibration report

This report shows the calibration details for a calibrated energy button. 

Figure 4-31. Dose calibration report

• The date and time on the Dose Calibration report will be the date and time of calibration as 
determined by the PC system clock. 

• Temperature is only shown if the calibration factor is negative.

• The temperature coefficients show 0.0 if temperature coefficient measurement has not been 
done.

• This report will be printed when the calibration coefficients are displayed in dose calibration.

• Signature space for physicist.
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5 Reference information

Calculations

This section describes calculations performed by the display unit on the raw data obtained from 
the detector diodes and is provided as reference information for the radiation physicist.

Background

Display builds a FIFO array with the counter data from the POD and a time value (in seconds) from 
the 16 millisecond clock on the Pod. This array is cleared each time an energy key or Stop is 
pressed.

The array looks like:
A(1,1)=T(1), A(1,2)=A(1), A(1,3)=B(1), A(1,4)=C(1), A(1,5)=D(1);
A(2,1)=T(2), A(2,2)=A(2), A(2,3)=B(2), A(2,4)=C(2), A(2,5)=D(2);
…;
A(32,1)=T(32), A(32,2)=A(32),A(32,3)=B(32),A(32,4)=C(32),A(32,5)=D(32).

Where: T(n) = time stamp of the nth counter values for channels A, B, C, D, with T(1) being the 
most recent and T(32) being the oldest.

When a calibrated energy key is pressed, calculate the background rates before clearing the array.

CAUTION: Note conditions below. 

Find first subscript n such that A(n,1) – A(1,1) > 20, i.e., calculate the background from the most 
recent 20 seconds of data.

where BKGA, BKGB, BKGC, BKGD are the background counting rates for channels A, B, C, D.

Background calculation conditions:

• Recalculate BKGA, BKGB, BKGC, BKGD after an energy key is pressed only if A(1,1)-A(old-
est,1) ≥ 20. i.e. we have collected a full 20 seconds worth of background again, otherwise use 
the prior values of BKGA, BKGB, BKGC, BKGD previous to the energy key being pressed.

• If new BKGA, BKGB, BKGC, BKGD is < 10 (25 pA), replace previous value with the new value.

• If new BKGA, BKGB, BKGC, BKGD is ≥ 10, replace previous value with 0. Display ‘~’ next to 
the dose results in the Dose screen, and display lower case a, b, c, when displaying charge 
results.

• Example: Old BKGA = 3.53, BKGB = 2.88, BKGC = 4.34, BKGD = 3.21

a. A(20,1) – A(1,1) = 20, 1st condition passes, calculate new backgrounds

b. New BKGA = 4.39, BKGB = 2.58, BKGC = 11.34, BKGD = 3.56

c. Replace backgrounds as BKGA = 4.39, BKGB = 2.58, BKGC = 0, BKCD = 3.56

d. Something failed in channel C, but A,B, and D are OK.

• Example: Old BKGA = 3.53, BKGB = 2.88, BKGC = 4.34, BDGD = 3.21

a. A(19,1) – A(1,1) = 19, 1st condition fails, do not calculate new backgrounds

• Note that it is possible, if we miss a communication, that the A(n,1) – A(1,1) > n.

BKGA
An 2, A1 2,–

An 1, A1 1,–
--------------------------= BKGB

An 3, A1 3,–

An 1, A1 1,–
--------------------------= BKGC

An 4, A1 4,–

An 1, A1 1,–
--------------------------= BKGD

An 5, A1 5,–

An 1, A1 1,–
--------------------------=
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Data collection

At the beginning of the measurement, when the Pod is told to start measuring, the 16 millisecond 
counter is zeroed. During Measurement, calculate the Dose and Rate from the FIFO array as 
follows:

Dose:

where DA, DB, DC, DD are the dose values for channels A, B, C, D and CFbtn,A, CFbtn,B, CFbtn,C, 
CFbtn,D, are the Calibration Factors for channels A, B, C, D on energy button ‘btn.’ (Tempcf)btn,cnr 
is defined below, cnr being A, B, C, D. This assumes that the timer counter was zeroed, i.e., A1,1 
is the true elapsed time since pressing the energy key.

Rate:

where the RA, RB, RC, RD are the dose rate values for channels A, B, C, D during the past time 
interval of A1,1 to A2,1.

Temperature correction factor 

This section describes how the IVD Control Module allows users to set up temperature compen-
sation for their diodes.

The routines are accessed from the “Temperature Coef” item from the main menu. A PIN code is 
required to proceed, followed by 1 to 4 serial numbers. After the serial numbers are selected and 
enter is pressed, the display then scans the active Pod’s calibration files, flagging as selectable 
those which contain any of the chosen serial numbers. You can then choose which calibration(s) 
are to be adjusted.

Two coefficients are associated with each diode pertaining to temperature: Tc and V’. Tc is the 
diode’s change in sensitivity with respect to temperature. Its label is percent per degree Celsius. 
A typical value for this is 0.5%/deg, which is stored internally as 50. V’ is a factor which allows the 
IVD display to determine relative diode temperature from the diode’s junction voltage. Its units are 
millivolts per degree Celsius (typical value, -2.0mV/deg, which is stored as 200). Formulae for Tc 
and V’ are provided below. 

After you select your calibrations, you are presented with the option of either entering Tc and V’ 
manually for each detector, or finding the coefficients through an experiment. If they are entered 
manually, the values are simply stored in the selected calibrations for the selected detectors, and 
the setup is complete. 

For diodes with unknown coefficients, or to verify a coefficient, the IVD allows for an experiment 
instead of manual entry. 

Materials required for the experiment:

• An IVD system with diodes connected

• A 3 cm thick acrylic or solid water phantom 

• A laboratory thermometer with 0.1 degree C resolution

DA A1 2, A1 1,– BKGA⋅[ ] CFbtn A, Tempcf( )btn A,⋅ ⋅=

DB A1 3, A1 1,– BKGB⋅[ ] CFbtn B, Tempcf( )btn B,⋅ ⋅=

DC A1 4, A1 1,– BKGC⋅[ ] CFbtn C, Tempcf( )btn C,⋅ ⋅=

DD A1 5, A1 1,– BKGD⋅[ ] CFbtn D, Tempcf( )btn D,⋅ ⋅=

RA A1 2, A2 2,–( ) A1 1, A2 1,–( )– BKGA⋅[ ] CFbtn A, Tempcf( )btn A,⋅ ⋅=

RB A1 3, A2 3,–( ) A1 1, A2 1,–( )– BKGB⋅[ ] CFbtn B, Tempcf( )btn B,⋅ ⋅=

RC A1 4, A2 4,–( ) A1 1, A2 1,–( )– BKGC⋅[ ] CFbtn C, Tempcf( )btn C,⋅ ⋅=

RD A1 5, A2 5,–( ) A1 1, A2 1,–( )– BKGD⋅[ ] CFbtn D, Tempcf( )btn D,⋅ ⋅=
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• A Zip-Loc (or equivalent) sandwich bag. (7x8”)

• Adhesive tape

• Water

Mount the thermometer to the buildup with tape, and mount the detectors face-down to the 
buildup. For maximum of 8 detectors, place the detectors and the thermometer uniformly along a 
5 cm circle in a 20x20 cm2 field at 100 cm SSD.

Fill the bag with 400mL of cold tap water, enough water that the bag is roughly 2 cm thick when 
sealed and laid flat. Try to avoid sealing in any large bubbles.

The first step on the IVD display after choosing the experimental route is “Apply cold bag to 
diodes.” 

Lay the bag flat over the diodes, and then press ENTER. The display will begin a 7-minute count-
down. This delay is to allow the system to reach thermal equilibrium. The countdown can be 
stopped early by pressing both the left arrow and the right arrow at the same time, but this is not 
recommended unless the bag really has been applied for at least 7 minutes.

After the delay, the system beeps and asks you for a temperature in degrees (from the thermom-
eter). Immediately after the temperature is entered, the diodes’ junction voltages are read and 
stored along with the entered temperature.   These numbers will be used to find the V primes.

Then, A 15-second background measurement is made, a beep is sounded, and you are presented 
with a dose-counting screen, with dosages in counts and an alternate message asking you to turn 
on the beam. Deliver a dose of 100 monitor units at any energy. When this is done, the dose is 
stored, along with the final junction voltage measurement after the dose measurement. These 
numbers will be used to find the Tc’s.

The next step on the IVD display is to “Apply hot bag to diodes,” and press Enter. The steps are 
the same as above except that now the bag is to be heated for 45 seconds in the microwave 
before application.

After the dose is delivered, you can use the hot and cold data sets to calculate all of your coeffi-
cients for each channel:

V’ = (ThotCts – TcoldCts) * 0.2265 / (ThotDeg – TcoldDeg)

Where ThotCts is the second junction voltage in counts measured after you enter the tempera-
ture, TcoldCts is the first junction voltage in counts, ThotDeg is the second temperature you enter, 
and TcoldDeg is the first temperature you enter.   The 0.2265 is the factor to convert junction volt-
age counts into milliVolts.

Tc = 100.0 * (DoseHot – DoseCold) / (DoseCold * (Thot – Tcold) * 0.2265/V’)

Where DoseHot is the second measured dose for a channel in background-compensated counts, 
DoseCold is the first measured dose, Thot is the junction voltage (in counts) following the second 
dose measurement, Tcold is the first junction voltage. V’ is the V’ described above.

Internally, these numbers are stored as unsigned short integers. For this reason, V’ is kept multi-
plied by –100 (i.e. –2.0 would be stored as 200) and Tc is kept multiplied by 100. (0.6 would be 
stored as 60.)

To apply these coefficients to correct a dose measurement, the formula is as follows:

DoseCorrect=DoseMeasured / (1+(Tc / 100) * (Tmeas – Tcal) * 0.2265/V’)

Where DoseMeasured is a background compensated and calibrated dose reading in Gy, cGy, etc., 
Tc is the Tc from above, Tmeas is the junction voltage following the dose measurement (counts), 
Tcal is the junction voltage following calibration, and V’ is the V’ from above.

Keep in mind that because Tc and V’ are stored as positive integers they will need to be divided 
by 100 and –100 respectively, before inserting them into the above equation.

Computing dose calibration factor for energy button ‘btn’

Calculate CF as follows:
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DA, DB, DC, DDare all equal since they are all the same dose, you enter after the calibration beam 
turns off.

There is no temperature correction because the calibration is at the temperature during calibra-
tion. That is, in the expression for Tempcf, the difference TMPcnr –TCALbtn,cnr during calibration is 
zero and TCALbtn,cnr gets saved with the calibration.

Error codes

Error codes allow Sun Nuclear technicians to quickly identify internal errors that could occur in the 
IVD system. When requesting customer service, you may be asked to display any error codes and 
report them. This information will allow the Sun Nuclear technician to evaluate the problem and 
find a solution. The intent of the error display is to aid the technician in troubleshooting.

Displaying error codes on the PC

When an error occurs, the letter “E” appears in the E column in Dose view. To view the meaning 
of the errors, right-click the “E” for the unit that is displaying it. An explanation of the error appears 
in a pop-up box (Figure 5-1).

Figure 5-1. PC error code display

Displaying error codes on display module
1 Be sure the system is properly connected and powered up.

2 On the Control Module, select the Software Version menu. See “To view the software ver-
sion” on page 58.

3 Key in the number “412” on the keypad. The error codes 
appear. It is possible that more than one error is displayed.

CFbtn A,
DA

A1 2, A1 1, BKGA⋅–[ ]
---------------------------------------------------=

CFbtn B,
DB

A1 3, A1 1, BKGB⋅–[ ]
---------------------------------------------------=

CFbtn C,
DC

A1 4, A1 1, BKGC⋅–[ ]
----------------------------------------------------=

CFbtn D,
DD

A1 5, A1 1, BKGD⋅–[ ]
----------------------------------------------------=

Error    

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
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4 View and record the 16 digits that appear on the bottom row of the LCD screen. 

5 To clear the error display, press ENTER. To leave, press STOP.

Reading error codes on the display module

Each Pod’s internal memory contains an ERROR CODE ARRAY (g_errs[8]) consisting of 8 bytes. 
Each byte represents an error “module,” and each module represents a group of functionally 
related errors. Each bit of the 8 bits in a module represents an error, for a total of 64 possible 
errors.

The errors are displayed, in hexadecimal format, in a row of 16 characters. The characters, from 
left to right, are in groups of two digits, designated A & B, and are associated to an error module 
group, designated Module_0 to Module_7 (Table 5-1).

To decode the displayed errors:

1 Read the hexadecimal value of a non-zero character. From its position, determine the module 
and whether it is “A” or “B.”

2 Using Table 5-2, read across for the hexadecimal character and determine which Error Bits 
are set, as indicated by the “X” in the column. 

3 Using the Error Bits that were set from Table 5-2, find the corresponding errors in Table 5-3 
for the Module group associated with the A-B combination.

Table 5-1. Arrangement of modules and A and B characters in the display

Module_0 Module_1 Module_2 Module_3 Module_4 Module_5 Module_6 Module_7

A B A B A B A B A B A B A B A B

Table 5-2. Bit errors set

hex
A

Error Bits Set hex
B

Error Bits Set
BIT 7 BIT 6 BIT 5 BIT 4 BIT 3 BIT 2 BIT 1 BIT 0

0 0

1 X 1 X

2 X 2 X

3 X X 3 X X

4 X 4 X

5 X X 5 X X

6 X X 6 X X

7 X X X 7 X X X

8 X 8 X

9 X X 9 X X

A X X A X X

B X X X B X X X

C X X C X X

D X X X D X X X

E X X X E X X X

F X X X X F X X X X

Table 5-3. Error Codes 

Error Mask Bit Comment
MODULE_0: SYSTEM INITIALIZATION (BYTE 0x0B2C)

ERR 1 BIT 0 BEEP - Battery Data Group is Corrupt (will attempt to use last group)

ERR 2 X BIT 1 BEEP - Both Battery Data Segment checksums are bad, using Defaults

ERR 3 X BIT 2 BEEP – Store Battery Data Failed

ERR 4 X BIT 3 BEEP - System Data Checksum/Data is bad, using Defaults
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ERR 5 X BIT 4 BEEP – Initialize Error Mask defaults Failed

ERR 6 X BIT 5 BEEP – Initialize System Data Defaults Failed

ERR 7 X BIT 6 BEEP – Clear old battery group data Failed

ERR 8 BIT 7
MODULE_1: SYSTEM (BYTE 0x0B2D)

ERR 9 BIT 0 Main program loop FAILED to service last RTI update (System too slow, > 
16.384ms) (Warning)

ERR 10 BIT 1 Battery capacity <90% of last capacity??? (Warning)

ERR 11 BIT 2 Battery capacity >110% of last capacity??? (Warning)

ERR 12 BIT 3 BEAM ON was detected in Background Mode

ERR 13 (not used)

ERR 14 X BIT 5 Could not AUTO Clear Caps (Electrometer problem?)

ERR 15 BIT 6 Background too high (channel a, b, c, d)

ERR 16 BIT 7 Battery Charge Problem?
MODULE_2: SYSTEM (BYTE 0x0B2E)

ERR 17 BIT 0 (not used)

ERR 18 BIT 1 (not used)

ERR 19 BIT 2 (not used)

ERR 20 BIT 3 (not used)

ERR 21 BIT 4

ERR 22 BIT 5

ERR 23 BIT 6

ERR 24 BIT 7

MODULE_3: SYSTEM (BYTE 0x0B2F)
ERR 25 X BIT 0 Channel “D” (ATD0) Counter Overflow occurred in current mode, BKGND or 

ACQ

ERR 26 X BIT 1 Channel “C” (ATD1) Counter Overflow occurred in current mode, BKGND or 
ACQ

ERR 27 X BIT 2 Channel “B” (ATD2) Counter Overflow occurred in current mode, BKGND or 
ACQ

ERR 28 BIT 3 Channel “A” (ATD3) Counter Overflow occurred in current mode, BKGND or 
ACQ

ERR 29 X BIT 4 Diode Channel “D” (ATD0) Rate Over Range was detected

ERR 30 X BIT 5 Diode Channel “C” (ATD1) Rate Over Range was detected

ERR 31 X BIT 6 Diode Channel “B” (ATD2) Rate Over Range was detected

ERR 32 X BIT 7 Diode Channel “A” (ATD3) Rate Over Range was detected
MODULE_4: SYSTEM (BYTE 0x0B30)

ERR 33 BIT 0

ERR 34 BIT 1

ERR 35 BIT 2

ERR 36 BIT 3

ERR 37 BIT 4

ERR 38 BIT 5

ERR 39 BIT 6

ERR 40 BIT 7

MODULE_5: SPI / SPI_AD (BYTE 0x0B31)
ERR 41 BIT 0 SPI Status Flag did not set

ERR 42 BIT 1 SPI Write Collision, SP0DR WCOL bit 6 set

ERR 43 BIT 2 SPI Mode Error interrupt, SP0DR MODF bit 4 set

ERR 44 BIT 3 SPI AD Converter Command not valid

ERR 45 BIT 4 SPI A/D select error

ERR 46 BIT 5

ERR 47 BIT 6

ERR 48 BIT 7

MODULE_6: SPI SERIAL EEPROM (BYTE 0x0B32)

Table 5-3. Error Codes  (Continued)

Error Mask Bit Comment
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Each Error bit set represents a single error. There could be multiple errors occurring 
simultaneously

NOTE: Not all module groups or bit ID’s have errors assigned. Some unassigned errors may be 
associated with future product changes.

Errors that are marked with an “X” in the Mask column are errors that allow the System Error Flag 
to be set. This will cause the Operation LED, DS2, to flash rapidly. This indicates a System Error 
caused by hardware or a condition that may cause data corruption.

Examples
0100000000000000 = ERR 1, Module_0, Battery group is corrupt

2000000000000000 = ERR 6, Module_0, Initialize error mask defaults failed

2100000000000000 = ERR 1 and ERR 6, Module_0

000100FF00000000 = ERR 9 Module_1, and ERR 25—32, Module_3

Using Model 1133/1135 components

You can mix different components from the IVD Solutions Models 1133/1135 (rf-IVD/wired IVD) 
and the IVD Solutions Models 1136/1137 (rf-IVD2 and IVD2). Although models 1133/1135 are no 
longer manufactured, you can use some parts of the Model 1136/1137 as replacements or to add 
to your existing installation as follows: 

• Add or replace Pods in your 1133/1135 system if you use PC control

• Use 1133/1135 Pods with your 1136/1137 system

• Upgrade your 1133/1135 system with PC control to use new software and a medical power 
supply

Differences between systems

The following differences between these systems will help you understand the possibilities.

Pods 

• Model 1133/1135 Pods have 3 channels (labeled A, B, and C) and use coaxial, 2-lug BNC 
connectors. 

ERR 49 BIT 0 SEEP Command not valid

ERR 50 BIT 1 SEEP Byte count not valid

ERR 51 BIT 2 SEEP Address not valid

ERR 52 X BIT 3 SEEP Write Verify failed 

ERR 53 BIT 4

ERR 54 BIT 5 SEEP Write Enable Latch bit did not set

ERR 55 BIT 6 SEEP Status Register write failed

ERR 56 BIT 7 SEEP Write In Process timeout
MODULE_7: RAM, BYTE EEPROM, FLASH (BYTE 0x0B33)

ERR 57 BIT 0 BYTE EEPROM Erase Failed

ERR 58 X BIT 1 BYTE EEPROM Write Verify Failed

ERR 59 BIT 2 BYTE EEPROM Command not valid

ERR 60 BIT 3

ERR 61 BIT 4 Memory address not valid

ERR 62 BIT 5 Memory data count not valid

ERR 63 BIT 6 Word is misaligned

ERR 64 BIT 7

Table 5-3. Error Codes  (Continued)

Error Mask Bit Comment
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• Model 1136/1137 Pods have 4 channels (labeled A, B, C, and D) and use coaxial, snap-on 
LEMO connectors. 

• The electrometer inside the Pod is functionally the same for all models.

• The radio frequencies and encoding are the same for Models 1133 and 1136.

Diode detectors

Diodes are the same except for connectors and can be used interchangeably. Older Isorad and 
QED diode detectors have the coaxial, 2-lug BNC plugs which mate with the BNC jacks on the 
model 1133 or 1135 Pods. Newer diodes have LEMO connectors. 

Adapters are available to interconnect any diode to any Pod. See Figure 2-1 for part numbers.

Power source

Models 1133/1135 use a standard DC power supply and rely on batteries to comply with FDA reg-
ulations prohibiting direct connection to patients. If power is inadvertently applied when the user 
is connected to a patient, software or firmware blocks operation and requires switching to a pro-
tected mode called “Physics Mode.” 

Model 1136/1137 uses a medical power supply, consequently,

• Physics Mode is not needed. 

• The Model 1137 wired Pod has no battery. The switch is not connected.

• You don’t use the battery in the Model 1135 wired Pod, but leave the switch on.

Control module and turtle

• A turtle (communications module) is not required with the 1136400 Control Module. It is built 
in.

• The 1136400 Control Module contains both serial and USB ports; you can connect a com-
puter via either port.

Software

Software for the 1136/1137 system includes support for four channels, an improved temperature 
calibration technique, multi-acquisition reports, and drivers for connection via USB. 

The 1136/1137 software can also be used with the 1133/1135 system when PC controlled.

Add or replace pods in 1133/1135 system

Although 1133/1135 Pods are no longed manufactured, you can use 1136/1137 Pods with your 
existing 1133/1135 Pods if you need add or replace Pods. However, you must upgrade your PC 
software to do this. See “Upgrade 1133/1135 system (only with PC control)” below.

Use 1133/1135 pods with 1136/1137 system

You can use 1133/1135 Pods directly with the 1136/1137 system. Please note the following 
differences:

• Energy calibration factors (Cf) are unchanged.

• When the software senses an 1133 or 1135 Pod, it will ask if you want to change the calibra-
tion table to the new format. 

• If you say yes, the calibration table format in the Pod is changed to the new format and 
the temperature calibration is set to zero. 

• If you say no, the table format is unchanged and the temperature calibration is left intact 
although it is not used. If you select no, the software will continue asking if you want to 
change the calibration table to the new format every time you connect the Pod.

• Temperature calibration for diodes connected to 1133/1135 Pods must be recalibrated using 
temperature calibration procedures for 1136/1137. 

• If you perform a temperature calibration, the calibration table is reformatted.

• You don’t use the batteries for 1135 wired Pods in an 1136 system, since the system is pow-
ered by a medical power supply. However, battery switches should be left on.
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NOTE: Always leave battery switches on Model 1135 pods in the ON position.

• Diodes with BNC and LEMO connector can be interchanged using the adaptors as long as 
each diode is calibrated on the Pod with which it is used. (Calibration factors are stored in the 
Pod.)

Upgrade 1133/1135 system (only with PC control)

Overview

You can upgrade your 1133/1135 system to use 1136/1137 Pods and to include new features in 
the software. To upgrade, you need to do the following:

• Purchase a new medical power supply, P/N 741008.

• Install new Model 1133/1135 software if you are using software control.

Medical power supply

The medical power supply, P/N 741008, replaces the original power supply, P/N 022000, which 
should be discarded. 

WARNING:  If you upgrade your system to use the new software on model 1133/1135, 
you must use the new medical power supply to comply with patient safety regulations.

New software

The new model 1133/1135 software adds the following functions:

• Lets you perform 4-channel measurement when using 1136/1137 Pods.

• Permits multi-acquisition report printing.

• Lets you enter temperature correction factors from a chart.

• Provides an improved method of temperature calibration. 

If you are using computer control, you must install the new software. See “To install the software” 
on page 41.

Temperature calibration

If you are using the 1136 PC software, you must update the temperature calibration for 1133/1135 
Pods. 

See “Temperature coefficient (Tc)” on page 62. 
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6 Service instructions

Repairs

User service

There are no user-serviceable parts in the IVD system components. If repairs are required, return 
the units to Sun Nuclear Corporation for repair.

Parts and supplies

See “Parts and accessories for the IVD Solutions” on page 9 for a list of components and part 
numbers.

To reorder rolls of thermal paper for the printer, order P/N 850043.

Battery maintenance

Detector pod battery charging

The rf-IVD2 Detector Pods contain an internal, rechargeable, NiMH battery. A new, fully-charged 
battery will operate continuously for about 350-400 minutes (5 to 7 hours). However, due to the 
intermittent duty cycle of the electronics, this charge will actually last for up to 12 hours of normal 
patient measurements. 

You should always begin each shift with a full charge. Battery charge status can be checked on 
the Control Module (see “Battery check” on page 20) or computer screen (see “To check the bat-
tery” on page 57). You should always recharge the batteries at the end of each shift and leave 
them on trickle charge when not in use.

To charge a battery
1 Place the battery switch in the ON position. 

CAUTION: Battery Switch must be ON in order to charge the battery! (1=ON)

2 Connect charging power using any of the following methods:

a. Place the Pod or Base in the powered wall bracket.

b. Connect the 25-meter cable P/N 1133550 from the powered Control Module to J5 on the 
Pod or base station.

c. Connect the 1-meter cable P/N 1133560 from J6 on the charging base station to J5 on 
the Pod.

3 It is a good practice, when not using the Detector Pod, to always keep charging power on all 
batteries. 

• It is not necessary to fully discharge the batteries for charging. There is special battery 
charging software that optimizes the battery charging. However, you may want to dis-
charge them to reset predicted battery life. See below.

• For a summary of possible connections, see “Connections” on page 10.

4 Verify batteries are actually charging. For detector Pods and Base Station, DS1 should be on 
blinking slowly for active charging, or on steady for trickle charge.

About predicted battery life

Since actual battery capacity cannot be measured directly, the Pod firmware uses an indirect cal-
culation to predict battery life. Both the Control Module and the software show the predicted 
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battery life. This is the remaining life that the Pod firmware predicts that the battery has when in 
operation. 

The predicted life of the battery assumes you are operating continuously, constantly reading and 
posting values. In practice, this rarely happens because a reasonable operating pace requires that 
you stop measuring during setup, changes of patients, etc. During this standby time, the Pod may 
be on, but no data is being collected. During standby, power consumption drops considerably. 
Assuming a reasonable duty cycle, a fully charged battery in good condition will have enough 
power for approximately 12 hours of treatment. Under these conditions, you would expect to 
begin the day with your predicted battery life at 6 hours, then, at the conclusion of an 8-hour shift, 
having used about 2/3 of the available battery power, your battery life should show 2 hours 
remaining.

However, over time, errors can creep into the predicted value so that predicted life is different than 
the actual life. To obtain predicted battery life, display software divides the estimated charge 
capacity of the battery at the present time by the nominal operating current of the Pod. Since no 
two batteries or circuits are exactly identical, the resulting battery life is only an estimate. The 
actual battery life will vary from to Pod to Pod. Over time, actual battery life will decline slowly.

By fully discharging the battery, you can reset the battery capacity. However, since the firmware 
limits the reset value to 10% of the predicted value, you may have to repeat the process several 
times to display an accurate battery life. To keep the predicted battery life equal to the actual bat-
tery life, you should perform a full discharge and recharge of the battery at least once a month. 
See “To reset battery predicted life” below. 

To reset battery predicted life

Occasionally, NiMH batteries appear to have different capacity than they actually do. In other 
words, the predicted battery life is more or less that the actual battery life.

Reset the battery predicted life to agree with the actual battery life as follows:

1 After working hours, turn the system on, turn on all batteries, press or click the Start button, 
and completely discharge the batteries (about 8 hours).

2 Charge the batteries fully (about 6 hours).
NOTE: You can automate the charging and discharging cycle overnight with a timer.

3 Resume normal operation. 

4 If the battery is not restored to actual capacity, repeat steps 1 and 2 several times until actual 
and predicted battery life agree. On each discharge cycle, predicted battery capacity is 
adjusted about ±10% of the predicted life. 

Software and firmware updates

Updating your software

Occasionally, updated IVD PC software may be made available on the Sun Nuclear web site. You 
can download the new software and install it in place of your existing software. Before download-
ing, check the version numbers to be sure the software posted on the website is a later version 
than the one you have. See “To view the software version” on page 58.

Updating your firmware

The IVD components contain firmware which is installed in non-volatile memory. During operation, 
the firmware installed in each component is executed by the on-board microprocessor to control 
the component and communicate with other components in the system. 

Firmware can be updated when a new release is available. Generally, new releases are posted on 
the SNC website.

Installing new firmware

To install new firmware:
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1 Verify that the firmware version to be installed is more recent than the firmware installed in 
your instrument. If using a PC as a control device, see “To view the software version” on 
page 58. If using the Control Module as a control device, see “Software version” on page 21.

2 Download the upgrade Installer from the SNC website (or run it from a SNC-supplied disk). 
Make a note of the directory in which you placed the software upgrade Installer.

3 Open Explorer, navigate to the directory containing the Installer, and run the Installer by dou-
ble-clicking its icon. 

• The installer will, by default, install the programs to the directory “C:\Program 
Files\SNC\SNCutility\IVD.” If you wish to install to a different directory, you may do so. 

• The Installer will be located in the Start > Programs > SNC Group > IVD Solutions menu.

4 Run the program called “Download to Control Module” by double-clicking its icon.

5 A window entitled “SNC Utilities” appears. The lower half of this window contains directions 
on how to connect the computer and go through the download process. Follow these instruc-
tions exactly and in order.

CAUTION: Failure to follow the instructions exactly can result in an unusable instrument.

6 After downloading the Control Module firmware, close the program. Run the “Download to 
Detector Pod” software, which is also located on the menu.

• Make sure you have the correct unit connected when using a particular Downloader.

• Don’t forget to download the new firmware to all of your Detector Pods and Base 
Stations!

7 After all firmware downloads are complete, either discard the software upgrade installer or 
save for your records. Do not confuse different versions of the software upgrade installer. 
When newer upgrade installers are installed, the old one will be overwritten so you always 
have the latest one installed.

Before requesting help

• Operator problems—Before requesting help from customer service, check to see if any of the 
following will solve your problem.

• Error messages—If you are getting error messages, see “Error codes” on page 80 for an 
explanation.

Contacting customer service

For customer service, contact:

Sun Nuclear Corporation 

425-A Pineda Court

Table 6-1. Solutions to operator problems

Problem Remedy
System does not operate. • Be sure main power supply is connected to the Control 

Module or computer.
• Recharge batteries.
• Turn on switches on Pod and Base.
• Recheck all connections to be sure they are properly set 

up. See “Connections” on page 10.

System will not find correct units. • Units from other systems may be operating within radio 
range. Turn off all other units that are not part of this sys-
tem or move the transceivers in this system into the treat-
ment room and remove all others from this treatment 
room.

All four LEDS (DS1-4) blinking rapidly. • Internal problem. Cycle power switch off and then back on 
to reset the software. If problem persists, contact custom-
er service.
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Melbourne, Florida 32940-7508

telephone 321-259-6862, fax 321-259-7979

e-mail Mail@sunnuclear.com or techsupport@sunnuclear.com

http://www.sunnuclear.com

Contact Sun Nuclear Corporation for the latest software revisions via e-mail to 
techsupport@sunnuclear.com.

Web site information

Additional service information is available on the SNC web site:

http://www.sunnuclear.com/

The web site contains information about the IVD as well as other SNC products.
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Warranty
1 INSTRUMENTATION

a. This instrument and its accessories, excluding those listed in 1.D. below, are warranted by SUN NUCLEAR 
CORPORATION, against defects in materials and workmanship for a period of one year from the date of orig-
inal purchase from SUN NUCLEAR CORPORATION. During the warranty period, SUN NUCLEAR 
CORPORATION will repair, or at its option, replace an instrument found to have such defect, at no charge to 
the customer.

THERE ARE NO WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING WITHOUT LIMITATION, ANY 
IMPLIED WARRANTY OF MERCHANTABILITY OF FITNESS, WHICH EXTEND BEYOND THE DESCRIPTION 
ON THE FACE HEREOF. THIS EXPRESSED WARRANTY EXCLUDES COVERAGE OF AND DOES NOT PRO-
VIDE RELIEF FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY KIND OR NATURE, INCLUDING 
BUT NOT LIMITED TO LOSS OF USE, LOSS OF SALES OR INCONVENIENCE. THE EXCLUSIVE REMEDY OF 
THE PURCHASER IS LIMITED TO REPAIR, RECALIBRATION OR REPLACEMENT OF THE INSTRUMENT AT 
THE OPTION OF SUN NUCLEAR CORPORATION.

b. This warranty does not apply if the product, as determined by SUN NUCLEAR CORPORATION, is defective 
due to either abuse, misuse, or modification or service performed by someone other than a SUN NUCLEAR 
CORPORATION authorized repair and calibration facility. Misuse and abuse include, but are not limited to, 
subjecting the instrument to environmental conditions outside the specified limits or allowing the instrument 
to become contaminated by radioactive materials.

c. In order to obtain warranty repair service, the instrument must be returned, freight prepaid, to the facility 
cited in 3.B. below. The purchase date, vendor invoice or customer purchase order should be included, along 
with a statement of the problem. Instruments will be returned transportation prepaid to points within the 
United States.

d. Because the original manufacturer’s warranty applies, the following items are specifically excluded from this 
warranty: photomultiplier, Geiger-Mueller, and proportional tubes; batteries; ancillary devices, including, but 
not limited to, printers, computers, display devices, etc.; and other components as may be specified in this 
manual.

2 CALIBRATION

a. This instrument is warranted to be within its specified accuracy at the time of shipment. If a question arises 
and SUN NUCLEAR CORPORATION determines that the initial calibration is in error, the instrument will be 
re-calibrated by SUN NUCLEAR CORPORATION at no charge. SUN NUCLEAR CORPORATION is not respon-
sible for calibrations performed by independent laboratories, nor any calibration fees incurred prior to or 
subsequent to SUN NUCLEAR CORPORATION warranty service.

b. The return policy is as stated in 1.C. above.

3 NON-WARRANTY SERVICE

a. Repairs and/or replacements not covered by this warranty may be performed by SUN NUCLEAR CORPORA-
TION or a factory authorized service location. Estimates of repair charges may be requested, however, a 
charge for estimate preparation may apply if the repair is later not authorized by the customer.

b. The cost of transportation into and out of the service location will be the responsibility of the customer. The 
instrument should be shipped to:

SUN NUCLEAR CORPORATION

425-A Pineda Court

Melbourne, FL 32940 U.S.A

Phone (321) 259-6862

Fax (321) 259-7979



Sun Nuclear Corporation
425A Pineda Court
Melbourne, FL 32940-7508
321-259-6862 Fax: 321-259-7979
www.sunnuclear.com

Document 1136011, Rev A
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